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Introduction

Product overview

The AnywhereUSB is the first remote networking solution to utilize USB over IP® technology. Since the host computer
or server may be located remotely, you can deploy AnywhereUSB devices in harsh or non-secure environments,
making it ideal for point-of-sale, kiosks, surveillance, industrial automation, or any mission-critical enterprise
application. This Ethernet-attached solution provides two, four, five, or fourteen USB ports to connect peripheral
devices such as USB license dongles, barcode scanners, receipt printers, as well as Digi Watchport®/V2 or Watchport®/
V3 USB Camera and Watchport Sensors.

The AnywhereUSB product line consists of the following models:

e AnywhereUSB/5 (first generation)

e Second generation AnywhereUSB models:

AnywhereUSB/2
AnywhereUSB/5 (G2)
AnywhereUSB/5M
AnywhereUSB/14
AnywhereUSB/TS44

The second generation AnywhereUSB devices provide a built-in web server and a command line interface (CLI) for
additional configuration options.
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AnywhereUSB hardware components

AnywhereUSB hardware components

The AnywhereUSB models have the following controls, ports, and connectors.

AnywhereUSB/2

Front panel Back panel

= asnesasuynsniuy

Item | Name Description

1 System Status LED When the device is powered on and during normal operation, the System Status
LED blinks slow green. If the System Status light blinks red for an extended
period of time, contact Digi Technical Support.

2 USB LEDs and ports Two USB ports with two USB LEDs. The USB LEDs are solid green when any of the
USB ports are connected to a host computer. The USB LEDs are off when any of
the USB ports are not connected to a host computer.

3 Reset button Use this button to either restart the device or reset its configuration to factory
defaults.

4 Power connector Use the included power adapter.

5 Ethernet connector The left Ethernet LED is green when connected to a network and the right

Ethernet LED blinks orange when there is data transmission activity on the port.
Use a standard Ethernet cable.
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AnywhereUSB hardware components

AnywhereUSB/5 (G2 and M models)

The AnywhereUSB/5 (G2) and AnywhereUSB/5 M models have the same controls, ports, and connectors, as shown in
the following image of an AnywhereUSB/5 M.

Front panel

Back panel

om hame b

1 System Status LED When the device is powered on and during normal operation, the System Status
LED blinks slow green. If the System Status light blinks red for an extended
period of time, contact Digi Technical Support.

2 USB LEDs Five USB LEDs. A USB LED is solid green when its USB port is connected to a host
computer. AUSB LED is off when its USB port is not connected to a host
computer.

3 Reset button When pressed, the Reset button either restarts the device or resets its

configuration to factory defaults.

4 Power connector Use the included power adapter.

The second generation AWUSB/5 (G2 and M) uses an improved center-
positive power supply with a locking barrel connector, which is different
than first generation AWUSB/5 devices. Power-supplies are NOT
interchangeable; use only the power supply provided with the device.

5 Ethernet connector The left Ethernet LED is green when connected to a network and the right
Ethernet LED blinks orange when there is data transmission activity on the port.
Use a standard Ethernet cable.

6 USB ports Five USB ports to connect USB devices.
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AnywhereUSB hardware components

AnywhereUSB/5 (first generation)

Front panel

AnywhereUSB/5

Back panel

Item Name Description

1 System Status LED On initial power-up, the System Status LED is orange for two seconds while the system
initializes and then blinks slow green. If DHCP is enabled and the device is booting up, the
System Status LED will be orange while the AnywhereUSB searches for a DHCP server. If it
cannotfind a DHCP server, it will return to the default configuration to allow the Configuration
Utility to assign a static IP address. If the System Status remains red for an extended period of
time, contact Digi Technical Support.

2 USB LEDs Five USB LEDs; note the following LED patterns:

e Green hunting pattern across all 5 USB LEDs: Not connected to a host computer.

e Orange alternating on ports 1-3-5 and 2-4: Updating image in Flash. Do not remove power
from AnywhereUSB while flash is being updated. Doing so will damage your
AnywhereUSB.

e Solid green: The USB ports are connected to a host computer.

e Green over red hunting pattern: Contact Digi Technical Support.

3 Power connector Use the included power adapter.

The first generation AWUSB/5 uses a center-negative power supply which is different
than the newer AWUSB/5 (G2) and AWUSB/5 M devices. Power-supplies are NOT
interchangeable; use only the power supply that is provided with the device.

4 Ethernet connector The left Ethernet LED is green when connected to a network and the right Ethernet LED blinks
orange when there is data transmission activity on the port. Use a standard Ethernet cable.

5 USB ports Five USB ports to connect USB devices.
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AnywhereUSB hardware components

AnywhereUSB/TS44

Front panel

AnywhereUSB

1 2 3

Back panel

Item Name Description

1 System Status LED When the device is powered on and in normal operation, the System Status LED
blinks green. If the System Status light blinks red for an extended period of time,
contact Digi Technical Support.

2 USB LEDs and ports Four USB ports and corresponding LEDs. AUSB LED is solid green when its USB
port is connected to a host computer. A USB LED is off when its USB port is not
connected to a host computer.

3 Reset button Use this button to either restart the device or reset its configuration to factory
defaults.

4 Power connector Use the included power adapter.

5 Ethernet connector The left Ethernet LED is green when connected to a network and the right

Ethernet LED blinks orange when there is data transmission activity on the port.
Use a standard Ethernet cable.

6 RS-232 RJ45 serial ports | Use these serial ports when using RealPort or for console access to the
AnywhereUSB device.
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AnywhereUSB hardware components

AnywhereUSB/14

Front panel

Back panel

4 5 4
EEEm e
1 System Status LED When the device is powered on and in normal operation, the System Status LED

blinks slow green. If the System Status light blinks red for an extended period of
time, contact Digi Technical Support.

2 USB LEDs and ports 14 USB ports with corresponding LEDs. AUSB LED is solid green when a USB port is
connected to a host computer. AUSB LED is off when a USB port is not connected to
a host computer.

3 Reset button Use this button to either restart the device or reset its configuration to factory
defaults.
4 Power connector The AnywhereUSB/14 has two power connectors. When using only one power cable,

you can use either of the power connectors. Use the included power cables.

5 RS-232 DB9 serial port  Use these serial ports when using RealPort or for console access to the
AnywhereUSB device.
6 Ethernet connector The AnywhereUSB/14 has two Ethernet connectors for redundancy. The left

Ethernet LED is green when connected to a network and the right Ethernet LED
blinks orange when there is data transmission activity on the port.

Use the ports as follows:
e LANL s the primary Ethernet port. Use this port when connecting only one

Ethernet cable or as the main Ethernet connection when connecting both
Ethernet ports.

e LAN2 is the secondary Ethernet port and is used only for redundancy. Only
connect an Ethernet cable to this port when you are already using LAN1.

Use a standard Ethernet cable.
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AnywhereUSB hardware components

Features

Following is an overview of configurable features of the AnywhereUSB/2, AnywhereUSB/5 (G2), AnywhereUSB/5 M,
AnywhereUSB TS44, and the AnywhereUSB/14 models.

User interfaces

There are several user interfaces for configuring and monitoring the AnywhereUSB family, including:

» Digi Device Discovery Utility, used to configure IP settings

e Web userinterface (Ul) for advanced configuring, monitoring, and administration
e AnywhereUSB command line interface (CLI)

¢ Simple Network Management Protocol (SNMP)

e AnywhereUSB Configuration Utility, used to connect/disconnect host computers

IP address assignment

There are several ways to assign an IP address to an AnywhereUSB:
e Static IP: Assign a specific IP address to a device, through the Digi Device Discovery Utility, the web Ul, or the CLI.

e Dynamic Host Configuration Protocol (DHCP): This is enabled by default. Use DHCP to automatically assign IP
addresses, to deliver TCP/IP stack configuration parameters, such as the subnet mask and default gateway, and
to provide other configuration information.

e Auto Private IP Addressing (APIPA), also known as Auto-IP: A standard protocol that will automatically assign an
IP address from a reserved pool of standard Auto-IP addresses to the computer on which it is installed. The device
is set to obtain its IP address automatically from a DHCP server. But if the DHCP server is unavailable or
nonexistent, Auto-IP will assign the device an IP. If DHCP is enabled or responds later or you use ADDP, both will
override the Auto-IP address previously assigned.

Security features

Security-related features in AnywhereUSB include:

e Secure access and authentication to the web Ul and CLI.
e One password, one permission level.
» Selectively enable and disable network services such as ADDP, HTTP/HTTPS, SSH, SNMP, and telnet.

e Encrypted AnywhereUSB traffic: An optional setting that allows a host computer to confirm the AnywhereUSB
device authenticity and to encrypt USB-over-IP traffic.

Configuration management

After an AnywhereUSB is configured and running, periodically perform any necessary configuration-management
tasks, such as:

e Upgrade firmware

e Upgrade device driver

e Back up device configuration

¢ Reset to factory default settings
o Restart the device
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AnywhereUSB hardware components

RealPort software

The AnywhereUSB TS44 and AnywhereUSB/14 use RealPort COM port redirection for Microsoft Windows
environments. RealPort software provides a virtual connection to serial devices, no matter where they reside on the
network. The software is installed directly on the host computer and allows applications to talk to devices across a
network as though the devices were directly attached to the host. Actually, the devices are connected to a Digi device
somewhere on the network.

RealPort is unique among COM port re-directors because it is the only implementation that allows multiple
connections to multiple ports over a single TCP/IP connection. Other implementations require a separate TCP/IP
connection for each serial port. Unique features also include full hardware and software flow control, as well as
tunable latency and throughput.

Encrypted RealPort

AnywhereUSB/14 and AnywhereUSB TS 44 supports RealPort software with encryption. Encrypted RealPort offers a
secure Ethernet connection between the COM port and an AnywhereUSB device. Encryption prevents internal and
external snooping of data across the network by encapsulating the TCP/IP packets in a Secure Sockets Layer (SSL)
connection and encrypting the data using Advanced Encryption Standard (AES), one of the latest, most efficient
security algorithms.

The Digi RealPort with encryption driver has earned Microsoft's Windows Hardware Quality Lab (WHQL) certification.

Drivers are available for a wide range of operating systems. It is ideal for financial, retail/point-of-sale, government or
any application requiring enhanced security to protect sensitive information.

You can enable or disable access to the Encrypted RealPort service.

For details, visit the Digi Support site at www.digi.com/resources and search for the RealPort Installation User’s
Guide.
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Getting started

This chapter explains what comes with each AnywhereUSB model, how to connect the hardware, and installing the
necessary software.

What’s in the box?

All AnywhereUSB models include the following hardware in the box:
e AnywhereUSB device
e Powersupply*

*AnywhereUSB/14 domestic orders include two power cords.

Connect the hardware
You need a standard Ethernet cable, your AnywhereUSB device and power supply to complete these steps.

1 Connectastandard Ethernet network cable to the Ethernet port on the back of the AnywhereUSB device and the
other end to the Ethernet port on a switch.

2 Connect the power supply or power cord (AnywhereUSB/14) to the power connector on the back of the
AnywhereUSB device and the other end into a power outlet.

For the AnywhereUSB/14, you can use either power connector on the back on the device.

Before using the AnywhereUSB, you need to install the driver software, configure the IP address, and set up security
(optional).

Install the driver software

You need a Microsoft Windows computer (host computer) to download and install the AnywhereUSB driver software
from the Digi International Support website. The driver software includes the AnywhereUSB Remote Hub
Configuration Utility.

1 Visit www.digi.com/support/product-support.
2 Find and select AnywhereUSB from the product list.
3 Select your AnywhereUSB model.
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Install the driver software

4 Download the appropriate driver software for your operating system.
5 Install the AnywhereUSB driver on the host computer.

6 Repeat this process for each host computer.

Note “Hostcomputer” refers to a Microsoft Windows-based computer that you use to connect to the
AnywhereUSB. In a virtual environment, the host computer is the Windows-based virtual machine. You do not
need to install the AnywhereUSB drivers on the physical server running the virtual machine (sometimes
called host).

After the driver software installs, the AnywhereUSB Remote Hub Configuration Utility opens. The utility automatically
discovers AnywhereUSB devices on the local subnet and displays configuration information, including the DHCP
address for a device.
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Initial AnywhereUSB configuration

After connecting the hardware and installing the software, you can connect the device to the network and configure
additional options, such as a static IP address, USB port groups, and encryption.

Configure the IP address

When successfully connected to a network, each AnywhereUSB device gets an IP address. The first generation
AnywhereUSB/5 model has a default static IP address and the second generation AnywhereUSB/2/5/5M/14/TS44
models have dynamic IP addresses. You can make changes to the IP address, such as assigning a static IP. Make sure
you follow the instructions for your AnywhereUSB model.

Note The host computer running Digi Device Discovery Utility and the AnywhereUSB device must be on the same
subnet.

AnywhereUSB/5 (first generation)

By default, first generation AnywhereUSB/5 models support DHCP, but have static IP addresses.
Default IP address configuration:

e |Paddress: 192.168.254.222

e Subnet mask: 255.255.0.0

To configure a static IP address:

1 Openthe AnywhereUSB Remote Hub Configuration Utility, which is included in the driver software you
previously downloaded and installed. See Install the driver software on page 15.

Select your AnywhereUSB/5 from the list on the left.
Click Configure.

Type the IP address, subnet mask, and default gateway.

i A W N

Click Update.
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Configure the IP address

AnywhereUSB (second generation)

DHCP is enabled by default on all second generation AnywhereUSB models.

The host computer connects only by using the AnywhereUSB IP address. If the AnywhereUSB IP address changes, the
connection is lost. We recommend assigning a static IP address to make sure your device always has the same IP
address and remains connected to the host computer. You can use either the web Ul or the Digi Device Discovery
Utility to configure the IP address.

Second generation AnywhereUSB models include:
e AnywhereUSB/2

e AnywhereUSB/5 (G2)

e AnywhereUSB/5M

e AnywhereUSB TS44

e AnywhereUSB/14

Configure the IP address with Digi Device Discovery Utility
Use the Digi Device Discovery Utility to:
e Seethe IP address of an AnywhereUSB device.

e Configure a static IP address when the AnywhereUSB does not obtain an IP address from a DHCP server (such as
when there is no available DHCP server).

Note You must run the Digi Device Discovery Utility from a computer on the same subnet as the AnywhereUSB. If
discovery fails, make sure that the Microsoft Windows Firewall is off. For additional troubleshooting help, visit
the Digi Knowledge Base at knowledge.digi.com.

To configure a static IP address using the Digi Device Discovery Utility:
1 Download and install the Digi Device Discovery Utility:

a Visit www.digi.com/support/product-support.
b Find and select Device Discovery from the product list.

¢ Download the utility for your operating system and install it.
Open the Digi Device Discovery Utility.

2
3 Right-click your AnywhereUSB device and select Configure network settings.
4 Typethe IP address, subnet mask, and default gateway.

5

Click Save.

Configure the IP address with the web Ul
Use the AnywhereUSB Configuration and Management web Ul to configure the AnywhereUSB with a static IP address.
To configure a static IP address using the web Ul:

1 Openaweb browser and type the AnywhereUSB IP address in the URL field. If you do not know the device IP
address, use the Digi Device Discovery Utility or the AnywhereUSB Remote Hub Configuration Utility to get the IP
address or connect directly to the web Ul.
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Configure AnywhereUSB encryption

2 Select Configuration > Network.

a Select Use the following IP address.

b Type the IP address, subnet mask, and default gateway.
3 Clearthe Enable AutolP address assignment check box.

4 Click Apply. The network settings are updated and the web Ul refreshes.

‘@ AnywhereUSB/5 MHC Configuration and Management
LRy

@ Help

Home Network Configuration

Configuration ~ Ethernet IP Settings (eth0)
Network

System

Remote Management
Security ® Use the following IP address:

Applications *1p Address:  [152.168.1.14
RealPort USB “ Subnet Mask:  [255.255.255.0
n Default Gateway:  [192.168.1.1

Administration [ Enable AutolP addre: ignment
X.500 Certificate/Key
Management * Changes to DHCP, IP address,
Backup/Restore

Update Firmware Apply

Factory Default Settings
System Information » Network Services Settings

' Obtain an IP address automatically using DHCP =

, and Subnet Mask may effect your browser connection.

Reboot » Advanced Network Settings

Logout:

Note You can also use the AnywhereUSB CLI as an alternative to the web Ul. For details, see Configure from the
command line on page 51).

Configure AnywhereUSB encryption

You can encrypt AnywhereUSB traffic by installing a digital certificate on the device. This is an optional setting that
allows a host computer to confirm the AnywhereUSB device authenticity and to encrypt USB-over-IP traffic. This
digital certificate must be signed by a Trusted Certificate Authority (CA). Since an AnywhereUSB is not publicly
accessible, an enterprise CA can self-sign the digital certificate.

To configure and enable encryption, you need to:

1 Create and validate the CA certificate.

2 Install the CA certificate on the AnywhereUSB device.
3 Enable the encrypted AnywhereUSB network service.
4

Install the CA certificate on the host computer.

Create and validate the CA certificate

Use OpenSSL tools to generate a CA certificate and then use it to sign device certificates.

1 Download the OpenSSL command line app from openssl.org.

2 Create a CA certificate (cacert.crt) and its private 2048-bit RSA key (cakey.pem) and store cakey.pem in a safe
place.

openssl req -nodes -new -newkey rsa:2048 -x509 -extensions v3_ca -keyout cakey.pem -out cacert.crt -days
3650 -subj "[your email information]”

Use the following email information string as an example: /C=US/ST=MN/L=Townname/O=Companyname/
OU=Department/emailAddress=email@company.com/

You will install cacert.crt on your host computer in a following step.
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Configure AnywhereUSB encryption

Generate a private 2048-bit RSA key for the server and store server.key in a safe place.
openssl genrsa -out server.key 2048

Generate a Certificate Signing Request file server.csr. For example:

openssl req -new -key server.key -out server.csr -subj "[your email information]”
With server.csr, generate the actual certificate (server.crt).

openssl x509 -req -days 3650 -CA cacert.crt -CAkey cakey.pem -set_serial 001 -in server.csr-out server.crt

Now validate the certificates to each other. If this command is successful, the server.crt: OK message appears. If
this command fails, an error message appears.

The private CA key is not used in this step.

openssl verify -CAfile cacert.crt server.crt

After successfully completing certificate validation in the previous step, concatenate server.crt and server.key to
create server.pem.
copy server.crt server.pem

type server.key >> server.pem

Install the CA certificate on the AnywhereUSB device

Upload the CA certificate to the AnywhereUSB device using the AnywhereUSB web Ul:

1
2
3
4
5
6

Open the AnywhereUSB web Ul with a web browser.

Select Administration > X.509 Certificate/Key Management.

Click Secure Sockets Layer (SSL)/Transport Layer Security (TLS) Certificates.
Click Identity Certificates and Keys.

Click the Choose File and browse to of server.pem file.

Click Upload.

Enable the Encrypted AnywhereUSB network service

You must enable the encrypted AnywhereUSB network service:

1
2
3
4
5

Open the AnywhereUSB web Ul with a web browser.
Select Configuration > Network.

Click Network Services Settings.

Select the Enable Encrypted AnywhereUSB check box.

Clear the Enable AnywhereUSB check box, if it is selected.

Note Enable AnywhereUSB is enabled by default. Make sure to enable only the Encrypted AnywhereUSB network

service. If both of the AnywhereUSB network services are enabled, you risk having unencrypted connections
on the device.

6

Click Apply.
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Configure AnywhereUSB encryption

Install the CA certificate on the host computer

Use the AnywhereUSB Remote Hub Configuration Utility to install the CA certificate on the host computer.

1
2
3
4

Open the AnywhereUSB Remote Hub Configuration Utility.
Select your AnywhereUSB device.
Click Configure.

Select the Encrypt Connection check box.

Note Tunnel connections is automatically selected when you select Encrypt connection.

5
6

Browse to or type the path of the CA certificate (cacert.crt) in the Digital Certificate field.
Click Update.
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Connect a host computer to AnywhereUSB

This chapter explains how to configure the host computer to establish a connection to the AnywhereUSB device using
the AnywhereUSB Remote Hub Configuration Utility.

Connect to the AnywhereUSB

To use the USB devices that are attached to the AnywhereUSB, the host computer must first establish a connection to

the AnywhereUSB.

Note For AnywhereUSB/5M and AnywhereUSB/14 multi-host models, assign groups before connecting to the host
computer through the AnywhereUSB web UI. For details, see Multi-host connections on page 31.

1 Loginto a Microsoft Windows computer with an account that has administrative privileges.

2 Select Start > Programs > AnywhereUSB > AnywhereUSB Remote Hub Configuration Utility.

The utility displays a list of all AnywhereUSB devices on your local subnet and on any subnet configured in the

Discovery List.

a'é AnywhereUSB Remote Hub Configuration Utility

= X

File Edit Command View Help

et

Configure Connect

Host PC Connection Status:

E glg Subnet1921681.0
Ay

A 92168.15]
AnpwherelISB/S G2 1921681 50]

Currently configured Group is 1

Group 1is available

Remats Hub Information Graup HostList
Name: AnywhereUSB/2 1 |Available
Serial Number:  AA12345678 2

3 —
MAC Address: ~ 00101A:12B45C 4 |—
IP Address 192.168.1.2 5 |—
Subnet Mask: ~ 255.255.255.0
Gateway: 192.168.1.1
DHCP: Disabled
Boot Code: v1.0.0123
Firmware: v.1.23.4567
Hardware: Rev A
Product Type: 2 Port
Device ID: Digi
Hardware |D: 0x1234
Uptime: 20 days - 7 hrs - 5 mins - 3 secs
ITDIE\ Discovered: 3 Connected To Me: 0 Available For Connection: 3 InUse By Others: 0 Unconfigured: 0
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Connect to the AnywhereUSB

3 Select an AnywhereUSB device from the device list in the AnywhereUSB Remote Hub Configuration Utility and
then either click Connect or right-click and connect to a group. The host computer then attempts to connect to
the AnywhereUSB.

The Connection Status now says Connected to this Host PC.

ﬂ'& AnywhereUSB Remote Hub Configuration Utility d

File Edit Command View Help

ee==e
Canfigure Caonnect
Hast PC Cannection Status:
El glg Subnet 192.168.1.0 Currently configured Group is 1
1.7]
AnywhereJSB/5 [First Gen) [132.168.1 5] Connected to this Host PC
* AnywhereUSB/5 G2 [192.168.1.50] Driver Status: Connect Successful to Remobe Hub at 192 168.1.2
Remaote Hub nformation: Group  HostList
Name: AnywhereUSB/2 1 Available
Serial Number: ~ AA12345678 2
3 |—
MAC Address:  00101A:12B45C 4 |—
P Address: 192.168.1.2 [ J P—
Subnet Mask: ~ 255.255.255.0
Gateway: 192.166.1.1
DHCP: Disabled
Boot Code v1.0.0123
Firmware v.1.23 4567
Hardware: Rev A
Product Type: 2 Port
Device 1D: Digi
Hardware 1D 0x1234
Uptime: 20 days : 7 hrs : 5 mins : 3 secs
ITma\ Discovered: 3 Connected To he: 0 Awvailable For Connection: 3 InUse By Cthers: 0 Unconfigured: 0

For details about the AnywhereUSB Remote Hub Configuration Utility, see AnywhereUSB Remote Hub
Configuration Utility on page 24.
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AnywhereUSB Remote Hub Configuration Utility

This chapter explains how to use the AnywhereUSB Remote Hub Configuration Utility.

Start the AnywhereUSB Remote Hub Configuration Utility
To start the AnywhereUSB Remote Hub Configuration Utility:
1 Login to a Microsoft Windows computer with an account that has administrative privileges.

2 Select Start > Programs > AnywhereUSB > AnywhereUSB Remote Hub Configuration Utility.

After the AnywhereUSB Remote Hub Configuration Utility has been started, it remains in the Windows system
tray. You can open the utility from the system tray by double clicking its icon.
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Remote Hub Configuration Utility window

Remote Hub Configuration Utility window

The AnywhereUSB Remote Hub Configuration Utility displays AnywhereUSB devices grouped by their subnet
addresses. The utility automatically discovers AnywhereUSB devices on the local subnet. To discover devices on
other subnets, add those subnet addresses to the Discovery List (see Discover AnywhereUSB devices on other
subnets on page 30).

ﬂ'é AnywhereUSB Remote Hub Configuration Utility d

File Edit Command View Help

s=mss
Configure Connect
Host PC Connection Status:
El g Subnet 132.1831.0 Currently configured Group is 1

12]
AnywherelISB/S (First Gen] [192.168.1.5] Connected to this Host PC
AnpuherelISB /5 G2 [192.168.1.50] Driver Status:  Cennect Successful to Remobe Hub at 192.168.1.2
(I AnpnerelISB /5 M [132.168.1.52]

Femote Hub Informetion G Ml
Name: AnywhereUSB/2 1 [Availsble
Serial Number:  AA12345678 H
3 |—
MAC Address:  00101A:12B845C 1 |—
IP Address: 192.168.1.2 5 |—
Subnet Mask:  255.255.255.0
Gateway: 192.168.1.1
DHCP: Disabled
Boot Code: v1.0.0123
Firmware: v.1.23.4567
Harcware: RevA
Product Type: 2 Port
Device D Digi
Hardware ID: 0x1234
Uptime: 20 days - 7 hrs : 5 mins - 3 secs
[Totel Discoverad: 3 Connected To Me: 0 Availahle For Connection: 3 In Use By Others: 0 Uncanfigured: 0

Icon Color Legend:

Icon Description

Green: Available for connection.
Gray with bold text: Connected to this computer.
Gray: In use by another host computer.

(AnywhereUSB/5 first generation only)

¢ ¢ 40

Red: Updating firmware.

@ Warning: The IP address is not configured, or this is a multi-host connections-enabled device
that is configured to connect to a non-existent Group.
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Menu options

Menu options

File menu: Preferences

— AnywhereUSB Remete Hub detection———————————

¥ Detect AmywhereUSE Remote Hubs automatically Save

5 3: Frequency of detection in seconds “Uninstall
— Detection Timeout

100 Detection Timeout (in Milliseconds)

—Advanced Option:

i

[ Use Microsott Device IDs

*Use Windows "Programs and Features' to Uninstall

Detect AnywhereUSB Remote Hubs automatically and Frequency of detection in seconds: Configure how often to
query the network for AnywhereUSB devices.

Note AnywhereUSB devices are automatically detected when you open the AnywhereUSB Remote Hub
Configuration Utility. Enabling this setting will make the AnywhereUSB Remote Hub Configuration Utility re-
scan the network for newer AnywhereUSB devices at the configured frequency.

Detection Timeout: configures how long the Remote Hub Configuration Utility will wait to hear from all the
AnywhereUSB devices before the Remote Hub Configuration Utility updates the list of devices in the Main Window.

Use Microsoft Device IDs: changes how the AnywhereUSB software creates the device ID for attached USB devices. A
device ID consists of three parts: the name of the bus driver, the Product Identifier, and a unique serial number. For
example, a Digi Edgeport USB to Serial converter that is plugged directly into the USB port of a computer would have
a Device ID similar to (where USB indicates the Microsoft USB bus driver):

USB\VID_1608&PID_0215\A20299384
When attaching devices to an AnywhereUSB device, the bus driver name is AWUSB. Therefore the same device
plugged into an AnywhereUSB device would have a Device ID of:

AWUSB\VID_1608&PID_0215\A20299384

Some USB class drivers expect to see the bus driver name as “USB”, and as a result will not operate unless the Use
Microsoft Device IDs checkbox is checked.

Edit menu: Connection List

The Connection List displays the IP addresses of the AnywhereUSB device to which the host computer will try to
connect. When an IP address is added to this list, the host computer immediately tries to connect to the
AnywhereUSB device. If an IP Address is deleted from the Connection List, the AnywhereUSB device will disconnect
from the host computer and return to an “Available for Host Connection” state.

Selecting an AnywhereUSB and clicking Connect adds the selected AnywhereUSB IP address to the Connection List.
Although we advise to connect using this method, you can also manually add the AnywhereUSB IP address to the
Connection List. Use the manual method when the AnywhereUSB device has a known IP address but is not
discoverable or when the AnywhereUSB is behind a router or firewall.
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Menu options

If an AnywhereUSB is behind a router or firewall, and port forwarding is being used, add the router's public-facing IP
address to the Connection List. Port 3422 TCP (or port 3423 for encrypted connections) should be used for port
forwarding.

Connection List Managel

Toconnectto a Remote Hub, add the IP address of the
Femote Hub to this list.

IF Address Group Number

Current Connection List.
192.168.1.2
192.168.1.5
192.168.1.50

Close
Add
Modify

Delate

adi

Delete All

Note Use Group 0 when manually adding an AnywhereUSB device that does not support multi-host connections.

Edit menu: Discovery List

The Discovery List Manager displays a list of subnet addresses of remote networks or IP addresses of individual
devices where the Remote Hub Configuration Utility will search for AnywhereUSB devices.

For details, see Discover AnywhereUSB devices on other subnets on page 30.

To discover Remote Hubs located an other netwarks,
add the IF address of the Remote Hub 1o this list.

IP Address

Discovery Address List:

Close
dd

Modity

Delete

Delete All

Il
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Command menu: Configure

The options in the Configure dialog depend on the model of the selected AnywhereUSB device.

AnywhereUSB/5 (first generation)

The Remote Hub field at the top-left is the friendly name for the first generation AnywhereUSB/5 that appears on the
left side of the AnywhereUSB Remote Hub Configuration Utility.

For the first generation AnywhereUSB/5, you can configure IP address settings in this window only.

AnywhereUSB/2 and AnywhereUSB/5 (G2) and AnywhereUSB TS 44

Use the Configure button to enable encryption for these AnywhereUSB models.

e For details about configuring AnywhereUSB IP settings, see Configure the IP address on page 17.
e For details about AnywhereUSB encryption, see Configure AnywhereUSB encryption on page 19.

e For details about configuring the AnywhereUSB device name, see System settings on page 43.

AnywhereUSB/5 M and AnywhereUSB/14

For the multi-host capable AnywhereUSB models, use the Configure button to configure the Group Number that the
host computer should connect to.

For details about multi-host connections, see Multi-host connections on page 31.
e For details about configuring AnywhereUSB IP settings, see Configure the IP address on page 17.
e For details about AnywhereUSB encryption, see Configure AnywhereUSB encryption on page 19.

e For details about configuring the AnywhereUSB device name, see System settings on page 43.

Command menu: Connect

Use the Connect command to add the IP address of the selected AnywhereUSB device to the Connection List.

Command menu: Web Ul

The web Ul command opens the web page of the selected device.

Note The first generation AnywhereUSB/5 does not have a web Ul.
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View menu: Driver Information

Use the Driver Information window to see AnywhereUSB driver version numbers and to uninstall older AnywhereUSB
drivers. To uninstall current AnywhereUSB drivers, use Microsoft Windows Programs and Features.

Filename Vergion|  Size | Date & Time ‘ Description ‘ Close I
awlshsys. sys 3.80.200 BEBE4 0B/09/201508:56:22 RemoteHub System Driver 64 bit

awnushd.sys 380,200 88400 0B/09/2015 08:56:28 RemoteHub USE Driver B4 bit *Uninstall
ionhub.sys 3.80.200 81720 0B/09/20750856:32 RemoteHub USE Hub Driver B4 hit

AwlshCfg.exe 3802000 4325. 06/09/201508:58:22 Configuration Utility
AwConsole exe 380200 1318.. 06/09/2015608:58:26 Remote Hub console config
Awlzhyiew exe 380200 1723 0B/09/201508:58:30 Remote USE Hub Viewer

*Use Windows "Programs and Features" to Uninstall

View menu: Refresh (F5)

The Refresh command updates information for discovered AnywhereUSB devices listed in the utility’s main window.
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Discover AnywhereUSB devices on other subnets

This chapter explains how to enable the AnywhereUSB Remote Hub Configuration Utility to discover AnywhereUSB
devices on additional IP subnets.

Adding IP addresses to the Discovery List

By default, the AnywhereUSB Remote Hub Configuration Utility scans the local subnet for AnywhereUSB devices. To
discover AnywhereUSB devices on other subnets, add their IP address or subnet to the Discovery List in the Discovery
List Manager Dialog box.

1
2

Select Edit > Discovery List.

Type the subnet address or the IP address of the individual device in the IP Address field.

For example, to add the Class C network 192.168.2.x, enter 192.168.2.255. For a Class B network 145.75.x.x, enter
145.75.255.255 (configure the router to forward subnet broadcasts).

Click Add.
Click Close to get back to the AnywhereUSB Remote Hub Configuration Utility main window.

Select View > Refresh. The device appears in the AnywhereUSB Remote Hub Configuration Utility device list.

Note If discovery fails, make sure that the Microsoft Windows firewall is off. For additional help, see No remote

hubs found on page 62.

To discover Remote Hubs located on other networks,
add the IP address of the Remote Hub to this list

IP Address

192 . 168 1 27|

Discovery Address List

Close
Add
Madity
Delste
Delats Al
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Multi-host connections

This chapter describes the multi-host connections feature exclusively available on the AnywhereUSB/14 and
AnywhereUSB/5 M models. The multi-host connections feature allows multiple host computers to establish
concurrent connections with the AnywhereUSB device. Each host computer requests a different group of USB ports,
where the group assignments have been previously configured on the AnywhereUSB device.

Requirement: Older AnywhereUSB driver and firmware versions may not support multi-host connections.

Configure groups
To assign the AnywhereUSB device's physical USB port to groups:
1 Open the web Ul for your device and select RealPort USB.

‘ﬁ AnywhereUSB/5 MHC Configuration and Management
oI

@ Help

Home RealPort USB Configuration

Configuration RealPort USB Settings
Network

System Default Group * | Group 1
Remote Management

Security USE Port 1 Group 1

USE Port 2 Group 1
Applications
RealPort USB USE Port 3 Group 1
USEB Port 4 Group 1
Management
Connections USE Port 5 Group 1

a4 4] 4|1 |

Administration
X.509 Certificate/Key
Management
Backup/Restore \ﬂl
Update Firmware
Factory Default Settings
System Informatien
Reboot

1 Default Group is being deprecated and can no longer be changed.

Logout

2 Click Apply and reboot the AnywhereUSB for group configuration changes to take effect.

The options on this page allows the user to select which physical USB ports on the AnywhereUSB device are
assigned to which group. By default, all the USB Ports are assigned to Group 1. Therefore, a host computer
requesting Group 1 takes ownership of all of the physical USB ports on the AnywhereUSB device.
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Configure groups

In the AnywhereUSB/14 configuration example below, a host computer requesting Group 1 is granted access only
to physical USB ports 1 through 4. A host computer requesting Group 2 is granted access to physical USB ports 5
through 7. A host computer requesting Group 6 is given access to physical USB port 11, and so on. The USB ports
12 through 14 are unassigned, and as a result do not support any attached USB devices.

‘@ AnywhereUSB/14 Configuration and Management
Oy

Home RealPort USB Configuration

Configuration RealPort USB Settings

Network
Serial Ports Default Group 1 Group 1 v
System & ]
Remote Management USE Port 1 roup v
Security USB Port 2 Group 1 v
Applications USB Port 3 Group 1 M
RealPort USE Port 4 Group 1 M
RealPort USB UsBPorts  [Group2 v
Management USB Port 6 Group 2 v
Serial Ports

USB Port 7 Group 2 M

Connections
USB Port 8 Group 3 v

Administration USB Port © Group 4 v
X.509 Certificate/Key
Management USE Port 10 Group & M
Backup/Restore USB Port 11 Group 6 v
Update Firmware USB Port 12 Unassigned v

Factory Default Settings

System Information USB Port 13 Unassigned v
Reboot USE Port 14 Unassigned v
Logout Enable Dynamic Group Assignment (DGA) *

1 pefault Group is being deprecated and can no longer be changed.

2 Enabling or Disabling DGA requires that the AnywhereUSE be rebooted.

Apply

In the example below, the AnywhereUSB/14 device has been configured to have 14 groups, each providing access
to a single physical USB port.

AnywhereUSB/ 14 Configuration and Management

\Dign

Home RealPort USB Configuration

Configuration RealPort USB Settings

Network

Serial Ports Default Group * Group 1 »

System

Remote Management L Group 1 b

Security USB Port 2 Group 2 v
Applications USB Port 3 Group 3 v

RealPort USB Port 4 Group 4 v

RealPort USB USB Port 5 Croups  +
Management USB Port 6 Group 6 v

Serial Ports USBPort7  [Group? ¥

Connections

USB Port 8 Group 8 v

Administration USE Port © Group 9 e

¥.509 Certificate/Key

Management USB Port 10 Group 10 v

Backup/Restore USB Port 11 Group 11 M

Update Firmware USE Port 12 Group 12 v

Factory Default Settings

System Information il Group 13 i

Reboot USB Port 14 Group 14 v
Logout Enable Dynamic Group Assignment (DGA) 2

1 pefault Group is being deprecated and can no longer be changed.

2 Enabling or Disabling DGA requires that the AnywherelSB be rebooted.

Apply
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Dynamic group assignment

The AnywhereUSB/14 device allows you to change group assignments without restarting the device using Dynamic
Group Assignment (DGA). Making group changes using DGA does not disrupt unaffected USB ports. For example, if
you enable DGA and make changes to USB ports 1, 2 and 3, then USB ports 4-14 remain connected without any
interruption.

To enable DGA and make group changes:
1 Select the Enable Dynamic Group Assignment (DGA) check box.
2 Click Apply and restart the device.

Enabling or disabling DGA requires you to restart the device.

3 Openthe web Ul and click RealPort USB.
4 Change groups for USB ports as needed.
5 Click Apply. Group changes take effect immediately.

‘@ AnywhereUSB/14 Configuration and Management
DI

@ Help

Home RealPort USB Configuration

Configuration RealPort USE Settings

Network

Serial Ports Default Group 1 Group 1 v

System

Security USB Port 1 Group 1
Applications USE Port 2 Greup 1

RealPort USB Port 3 Group 1

RealPort USB useport4 [ Group 1
Management USB Port 5 Group 2

Serial Ports

v
v
v
v
USB Port 6 Group2 v
Connections
USB Port 7 Group 2 v
Administration v
v
v
v
v

%509 Certificate/Key useports |Croup3
Management USE Port 9 Group 4
/|
Backup/Restore USBPort 10 [Group 5

Update Firmware

Factory Default Settings USE Port 11 Group &
System Information USB Port 12 Unassigned
Rebeot

usBPort 13 | Unassigned
Logout USB Port 14 Unassigned ¥
I Enable Dynamic Group Assignment (DGA) %

1 pefault Group is being deprecated and can no longer be changed.

2 Enabiing or Disabling DGA requires that the AnywhereUS8 be rebooted.

Apply
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Host computer configuration

In the AnywhereUSB Remote Hub Configuration Utility, you must specify the group number that each host computer
should connect to. Each host computer may only connect to one group. When the host computer connects to the
AnywhereUSB, it takes ownership of the associated USB ports.

The following example shows an AnywhereUSB/5 M device that has five groups configured, each group provides
access to a single physical USB port on the AnywhereUSB device.

In the Host List column is on the right, “available” indicates that the Group is associated with one or more USB ports
and there are no host computers currently connected to that Group.

the AnywhereUSB Remote Hub Configuration Utility (=1E] X

File Edit Command View Help

icj

Configure

—
Connect

Host PC Cannection Status;

EE)

Currently configured Group is 1

1152168151 Group 1is available
AnywherelSB/5 G2 (192168 1501

Remote Hub Infarmation Graup Host List

Name: AnywhereUSB/2
Serial Number: ~ AA12345678

Available
Available
Available
Available
Available

MAC Address: ~ 00101A'12B45C
IP Address 19216812
Subnet Mask: ~ 266.265.255.0
(Gateway 19216811
DHCP Disabled

Boot Code v.0.0123

Firmware: v.1.23.4567

Hardware

Product Type: 2 Port

Device ID Digi

Hardware ID: ~ 0x1234

Uptime: 20 days - 7 hrs < § mins : 3 secs

[Total Discovered: 3 Connected To Me:0 ‘Available For Connection: 3 InUse By Others: 0 Uncanfigured: 0

To connect an AnywhereUSB device to the host computer:
1 Loginto a Microsoft Windows computer with an account that has administrative privileges.
2 Select Start > Programs > AnywhereUSB > AnywhereUSB Remote Hub Configuration Utility.

3 Select your device from the list and click Connect or right-click and click Connect.

For example, the following image shows a host computer that connects to Group 4 on the AnywhereUSB device.
Clicking Connect initiates the connection process between the host computer and the selected AnywhereUSB/5
M device.

After the connection process completes, the AnywhereUSB Remote Hub Configuration Utility updates its
Connection Status information.

e AnywhereUSB Remote Hub Configuration Utility (=|E] X

file Edit Command View Help

& asese

Configure Connect

HostPC Connection Status:

This host PC will use Group 4 when connecting to this Remote Hub

g J[1921681.5] Connected to this host PC
AnpwherelISB/5 G2 (192163 150] Driver Status: Connection Successful to Remote Hub at 192.168.1.2

Remote Hub Informtion: Group HostList
iame- AnywhersUSE/2 1 [Available
Serial Number:  AA12345678 Available
Available
192.168.1.2
Available

IMAC Address: ~ 00101A-12B45C
92

Subnet Mask:  255.255.255.0
192.168.1.1

DHCP: Disabled

Boot Code: v1.00123
Firmware: v.1.23.4867

Hardware:
Product Type: 2 Port

3
Uptime: 20 days - 7 rs - 5 mins : 3 secs

[Totel Discovered: 3 Connected To Me: 1 ‘Available For Cannection: 3 InUse By Others: 0 Unconfigured: 0

Note The Host PC Connection Status now says “Connected to this Host PC,” and the host computer's IP address is
listed in the Host List column for Group 4.
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In the event the host computer requests a group that is not configured on the AnywhereUSB device, the Host PC
Connection Status displays something similar to the following image indicating that the selected Group is not
configured on the given AnywhereUSB device.

Hhe AnywhereUSB Remote Hub Configuration Utility =1E] X

File Edit Command View Help

= ssmms

Gonfigure Connect

Host PC Connection Status:

Sub
] gfg(D

This Host PC will use Group 5 when connecting to this Remote Hub

Group & is not configured on Remate Hub

Remate Hub Infarmation Group HostList

Name: AnywhereUSB/2 1 [Available

Serial Number:  AA12345678 2 |Available
3 |Available

MAC Address:  00101A:12B45C 4 |Available

IP Address 192.168.1.52 5

Subnet Mask: 255255 2550

Gateway: 192.168.1.1

DHCP: Disabled

Boot Code: v1.0.0123

Firmware v.1.234567

Harcware: Rev A

Product Type: 2 Port

Device ID Digi

Hardware ID: ~ 0x1234

Uptime: 20 days : 7 hrs 5 mins : 3 secs

ITD(a\ Discovered: 3 Connected To Me: 0 Awailable For Connection: 3 In Use By Others: 0 Unconfigured: 0

In the above example, the Host List column on the far right indicates that groups 1 through 4 are associated with one
or more USB ports, and there are no host computers currently connected with one or more of these groups. Group 5 is
not associated with any USB port, therefore it is not possible for a host computer to connect to it. When a host
computer is configured to connect to a group that is not associated with any USB ports on an AnywhereUSB device, a
yellow warning symbol appears next to the AnywhereUSB device in the Remote Hub Configuration Utility and a
message appears in the Host PC Connection Status area.
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Configure from the web Ul

This chapter describes using the web Ul Configuration, Management, and Administration sections and their sub-
menus. With the exception of the title of the specific Configuration and Management screens, menus and sub-menus
for both models remain the same. This feature is not available on the first generation AWUSB/5 model.

Home page

The home page appears when the web Ul is opened.

‘ﬁ_ AnywhereUSB/5 MHC Configuration and Management
o|h

@ Help

Configuration Getting Started
Network

System Tutorial Mot sure what to do next? This Tutorial can help.
Remote Management
Security System Summary

Applications
RealPort USB

Management
Connections

Administration
¥.500 Certificate/Key
Management
Backup/Restore

Model:
Ethernet MAC Address:

Ethernet IP Address:
Description:

Contact:
Location:

AnywhereUSB/5 MHC
00:10:1A:12:B4:5C

192.168.1.52
Mone

None
None

Update Firmware
Factory Default Settings
System Information
Reboot

Device ID: 00000000-00000000-00101A12-B45C6DTE

Logout

The left side of the home page has a list of choices that display pages for configuration, applications, management,
and administration tasks, and to logout of the web UI. Clicking Logout disconnects the configuration and
management session with an AnywhereUSB. It does not close the browser window, but displays a logout window. To
finish logging out of the web Ul and prevent access by other users, close the browser window. Or, log back on to the
device by clicking the link on the screen. After 5 minutes of inactivity, the idle timeout also automatically performs a
user logout.
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Applying and saving changes

The web Ul runs locally on the device, which means that the interface always maintains and displays the latest
settings for the connected AnywhereUSB device.

Canceling changes

To cancel changes to configuration settings, click Refresh or Reload in the web Ul. This causes the browser to reload
the page. Any changes made since the last time the Apply button was clicked are reset to their original values.
Restoring the AnywhereUSB to factory defaults

You can reset the device configuration to factory defaults as needed during the configuration process.

Online help

Online help is available for all screens of the web Ul, and for common configuration and administration tasks. There is
also tutorial available on the Home page.

The Getting Started section has a link to a tutorial on configuring and managing the AnywhereUSB.

The System Summary section notes all available device-description information.

Configuration

The configuration section of the web Ul consists of sub-menus that are specific to the particular model of the
AnywhereUSB device being configured. These configuration options may include: Network, Serial Ports
(AnywhereUSB/14 and AnywhereUSB TS44 only), System, Remote Management, and Security.

Network settings

View and change IP settings

The Ethernet IP Settings page shows IP address settings for the: DHCP or static IP address, subnet mask, default
gateway. Contact your network administrator for more information about these settings, and see the online help.

‘ﬁ_ AnywhereUSB/5 MHC Configuration and Management
of)
@ Help

Configuration
Metwork
System
Remocte Management

w Ethernet IP Settings (eth0)

® Obtain an IP address automatically using DHCP =

Security Use the following IP address:
Applications = 1P Address:  [192.168.1.62

Realbort;UISH * Subnet Mask:  [255 265,256.0
Management Default Gateway: _192 158.].1

Connections

Administration
X.500 Certificate/Key
Management
Backup/Restore
Update Firmware
Factory Default Settings
System Information
Reboot

Logout

[#! Enable AutcIP address assignment

* Changes te DHCP, IP address, and Subnet Mask may effect your browser connectien.

» MNetwork Services Settings

b Advanced Metwork Settings
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Enabling and disabling network services

The Network Services page shows a set of common network services that are available for the AnywhereUSB, and the
network port on which the service is running.

Several services have a setting for whether TCP keep-alives are sent for the network services. You can configure TCP
keep-alives in more detail on the Advanced Network Settings page.

1 AnywhereUSB/5 MHC Configuration and Management
\Digp
@ Helb

Home Network Configuration
Configuration b Ethernet IP Settings (eth0)

MNetwork

System + Network Services Settings

Remote Management

Security I# Enable Device Discovery (ADDP)
Applications |#| Enable Encrypted AnywhereUSB TCP Port: 3423 I [/ Enable TCP Keep-Alive

RealPort USB [l Enable AnywhereUSBe TCP Port: 3422 ,i '] Enable TCP Keep-Alive
Management |« Enable Network Management Protocol (SNMP) UDP Port: 161 ]

Connections [l Enable Secure Shell Server (S5H) TCP Port: [22 | Enable TCP Keep-Alive
Administration ¥ Enable Telnet Server TCP Port: |23 | O Enable Tcp Keep-alive

%5009 Certificate/Key —

Management |#| Enable Web Server (HTTP) TCP Port: \SD

Backup/Restore @ Enable Secure Web Server (HTTPS) TCP Port:  [443

Update Firmware

Factory Default Settings

|
System Information @
Reboot » Advanced Network Settings

Logout

You can enable or disable the common network services and configure the TCP port on which the network service
listens. You can disable services for security purposes so the device runs only those services specifically needed. To
improve device security, disable non-secure services such as telnet.

Enable or disable the following network services:

» Device Discovery (ADDP): This service controls use of Advanced Device Discovery Protocol. Ifitis disabled, you can
no longer use Digi Device Discovery utility to locate the device.

e AnywhereUSB and Encrypted AnywhereUSB: These services enable or disable the ability for a host computer to
connect with your AnywhereUSB device. You must enable only one of these options. Disabling both of these
options disconnects your AnywhereUSB device from the host computer. Use these options as follows:
= AnywhereUSB: Enable this to allow host computer connections to your AnywhereUSB device without

encrypting network traffic.
= Encrypted AnywhereUSB: Enable this option to allow host computer connections to your AnywhereUSB device
and to encrypt network traffic.

Note The TCP Port numbers for AnywhereUSB and Encrypted AnywhereUSB are static and cannot be changed.

e Network Management Protocol (SNMP): Enables or disables the use of SNMP. If disabled, SNMP services such as
traps and device information are not used.

e Secure Shell Server (SSH): Enables or disables the SSH server service. If disabled, users cannot make a Secure
Shell connection to the device.

e Telnet Server: Enables or disables the telnet service. If disabled, users cannot telnet to the device.

* RealPort or Encrypted RealPort: These services control use of COM port redirection. If disabled, COM port
redirection cannot be used for the device. (Applicable to AnywhereUSB/14 and AnywhereUSB TS44).

e Web Server (HTTP) or Secure Web Server (HTTPS): These services control the use of the web Ul. If you disable
them, device users cannot use the web Ul or Java applet to configure, monitor, and administer the device.
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Port numbers for network services

For each network service, the Port field shows the port on which the service is running. It is usually best to use the
default TCP port numbers for these services because they are well known by most applications.

IP network failover settings (AnywhereUSB/14 only)

The IP Network Failover feature allows the AnywhereUSB/14 to recover from an Ethernet failure. The failover
conditions are configurable, and once the AnywhereUSB/14 determines that the primary Ethernet link has failed, it
automatically routes the Ethernet traffic to the secondary Ethernet link.

Ethernet port use:

e LANListhe primary Ethernet port. Use this port when connecting only one Ethernet cable or as the main Ethernet
connection when connecting both Ethernet ports.

e LAN2 is the secondary Ethernet port and is used only for redundancy. Only connect an Ethernet cable to this port
when you are already using LAN1.

For more information about this feature on the AnywhereUSB/14 device, visit the Digi Knowledge Base at
knowledge.digi.com.

Advanced network settings

Use the Advanced Network Settings to further define the network interface.

3 AnywhereUSB/5 MHC Configuration and Management
\Digni
@ Help
Lipme Network Configuration
Configuration b Ethemet IP Settings (th0)
Network
System » Network Services Settings
Remote Management » Advanced Network Settings
Security
L. The following settings are advanced settings used to fine tune the network connection and network interfaces. The
Applications default settings will typically work in most situations.
RealPort USB
IP Settings
Management
Connections Host Name:
Administration
X.509 Certificate/Key Static Primary DNS:  [0.0.0.0
Management .
Backup/Restore Static Secondary DNS: 0000
Update Firmware
Factory Default Settings o
: Static
System Information DNS Priority: Ethemet —
Reboot
Logout
Ethernet Interface {ethD)
Etho Speed: | Auto A Duplex Mode: | Full-Duplex v
TCP Keep-Alive Settings
Idle Timeout: 0 hrs |0 mins 10 secs (10 secs - 24 hrs)
Probe Interval: 10 secs (10-79)
Probe Count: 5 probes (5-30)
Apply
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Settings include:

e Host Nameis placed in the DHCP Option 12 field. This is an optional setting which is only used when DHCP is
enabled.

e Static Primary/Secondary DNS are the IP addresses of Domain Name Servers (DNS) used to resolve computer host
names to IP addresses. Static DNS servers are specified independently of any network interface and its
connection state. An IP address of 0.0.0.0 indicates no server is specified.

e DNS Priority is a list of DNS servers in the order they are used to resolve computer host names. Each type of server
is tried, starting with the first in the list. For each server type, the primary server is tried first. If no response is
received, then the secondary server s tried. If it cannot contact either server, it tries the next server type in the list.
A network interface may obtain a DNS server from DHCP or other means when it is connected. If an interface does
not obtain a DNS server, it will be skipped and the next server in the priority list will be tried. To change the priority
order, select an item from the list and press the up or down arrow.

e Ethernet Interface permits the configuration of Ethernet speed and duplex settings.

e TCP Keep Alive Settings include an Idle Timeout which specifies the period of time that a TCP connection is idle
before a keep-alive is sent, a Probe Interval in seconds between each keep-alive probe, and a Probe count which
is the number of times TCP probes the connection to determine if it is alive after the keep-alive options has been
activated. The connection is assumed lost after sending this number of keep-alive probes.

Serial port settings (AnywhereUSB/14 and AnywhereUSB TS44 only)

Configure serial port

The Serial Ports page configures the serial port settings for the management port on the rear of the AnywhereUSB/14
and the four serial ports on the rear of the AnywhereUSB TS44.

Serial port configuration

Use the Serial Port Configuration page to establish a port profile for the serial port of the AnywhereUSB TS44. The
Serial Port Configuration page includes the currently selected port profile for the serial port, detailed configuration
settings for the serial port, dependent on the port profile selected, and links to Basic Serial Settings and Advanced
Serial Settings.

"l!-li AnywhereUSB TS44 Configuration and Management

9 Help

Home

Serial Port Configuration

Configuration

Port Description  Profile Serial Configuration Action
Network

SRS Port1 None Custom 9600 8N1 Copy...

System Port 2 None Custom 9600 8N1 Copy...

Remate Management Port 3 None Custom 9600 8N1 Copy...

Segunty Partd  None Custom 9600 8N1 Copy...
Applications

RealPort USB

Management
Connections

Administration
X.509 Certificate/Key
Management
Backup/Restore
Update Firmware
Factory Default Settings
System Information
Reboot

Logout
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About port profiles

Port profiles simplify serial port configuration by displaying only those items that are relevant to the currently
selected profile. There are several port profile choices, but not all port profiles are supported in all products. Support
of port profiles varies by product. If a profile listed in this description is not available on the page, it is not supported.

If a port profile has already been selected, it is shown at the top of the screen. You can change the profile, or retain it
and adjust individual settings.

Everything displayed on the Serial Port Configuration screen between Port Profile Settings and the links to the Basic
Serial Settings and Advanced Serial Settings depends on the port profile selected.

When using serial ports for the terminal emulator's host or keyboard connections, you must configure those ports for
the Custom port profile.

Select and configure a port profile:

To configure any profile, select Serial Ports.
Click the port to configure.

Click Change Profile.

Select the appropriate profile and click Apply.

aua A W N R

Enter the appropriate parameters for each profile; descriptions of each profile follow.
6 Click Apply to save the settings.

Alist of the ports available on the Digi device server along with a summary of each port's current configuration is
displayed when you select Serial Ports under the Configuration heading.

Edit port settings

Click the port's link under the Port heading.

Port profile

A port profile allows you to easily configure a serial port based on how you will be using that port. By selecting one of
the predefined profiles, the configuration options are focused only on the settings required for that particular profile.

For situations that do not fit into one of the predefined port profiles, select the Custom profile option. All of the port
options are available in the custom profile.

Port profile options:

e RealPort: Use this option to map a COM port to the serial port. You must have the RealPort driver installed on the
host computer. See the RealPort Installation User’s Guide for more information.

e Local Configuration: Use this option to connect standard terminals or terminal emulation programs to the serial
port. This allows the serial port to act as a console to access the CLI.

e Custom: Use this for advanced configuration options.

- AnywhereUSB/ 14 Configuration and Management
\Dign
@ Help

Hoee Select Port Profile...
Configuration - =

Network Profiles allow you to easily configure serfal ports by only displaying those items that are relevant to the current profile.

Serial Ports Select the profile below that best matches your configuration.

System

Remote Management © RealPort

Security The RealPort Profile allows you to map a COM or TTY port to the serial port. More..
Applications

sealm e © Local Configuration

ealPol
The Local Configuration Profile allows you to connect standard terminals or terminal emulation programs to the serial port in order to use the serial port as a console to access the command line interface. More...

Management

Serial Ports @ Glom

Connecti -

onmecine The Custom Profile is an advanced option to allow full configuration of the serial port. More...

Administration

X.500 Certificate/Key

Management

Backup/Restore Apply

Update Firmware

Factory Default Settings
System Information
Reboot

Logout
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Basic serial settings

‘DI I- i AnywhereUSB TS44 Configuration and Management

@ Help

Home

Serial Port Configuration - Port 1 Return to Serial Ports  + Pre

Configuration

Netwaork » Port Profile Settings

Serial Ports « Basic Serial Settings
System
Remote Management Description: ||
Security
ADRp“II::tri:EsSB Baud Rate: ‘9600 Vl
ealPor e
Data Bits: 8>
Management
Connections Parity: ‘ None v
Serial Ports Stop Bits: ‘ 1 v!
Administration Flow Control: | Software |
X.509 Certificate/Key
Management
Backup/Restore Apply,
Update Firmware = =
Factory Default Settings » Advanced Serial Settings
System Information
Reboot
Logout
Description

The Description specifies an optional character string that to use for identifying the device connected to the port.

Baud Rate
Data Bits
Parity

Stop Bits
Flow Control

The basic serial port settings must match the serial settings of the connected device. If you do not know these
settings consult the documentation that came with your serial device. These serial settings may be documented as
9600 8N1, which means that the device is using a baud rate of 9600 bits per second, 8 data bits, no parity, and 1 stop
bit.

When using RealPort (COM port redirection) or RFC 2217, these settings are supplied by applications running on the
computer or server and you do not need to change the default values on your Digi device server.

Advanced serial settings

The advanced serial settings rarely change.
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System settings

The System Configuration page configures system settings, including device description information, such as the
device name, contact, and location, and whether SNMP is enabled or disabled and the SNMP traps that are enabled.

‘@ AnywhereUSB/5 MHC Configuration and Management
OIS

@ Help

Home System Configuration

Cenfiguration w Device Identity Settings

Network
S Description:
Remote Management
Security Contact:
Applications Location:
RealPort USB
Management Device ID:  |00000000-00000000-00102AEB-CD3456E7

Connections

Administration

X.5009 Certificate/Key Apply
Management
Backup/Restore » Simple Network Management Protocol (SNMP) Settings

Update Firmware
Factory Default Settings
System Information
Reboot

Logout

Configure device description information

A device description is a system description of the AnywhereUSB name, contact, and location. Use the device
description for identifying a specific AnywhereUSB when working with a large number of devices in multiple
locations.

The information in the description field represents the “friendly” name of the AnywhereUSB device that
appears on the left side of the AnywhereUSB Remote Hub Configuration Utility.

Configure SNMP

Use the Simple Network Management Protocol (SNMP) protocol to manage and monitor network devices. Configure
Digi devices to use SNMP features, or disable SNMP for security reasons. To configure SNMP settings, click the SNMP
Settings link at the bottom of the System Configuration page.

‘@ AnywhereUSB/5 MHC Configuration and Management
O

@ Help

Homa) System Configuration

Configuration » Device Identity Settings

Network

System = simple Network Management Protocol (SNMP) Settings

Remote Management

Security ! Enable Simple Network Management Protocal (SNMP)
remm— Public community:  [public

RealPort USB Private community: private
Management

Connections Allow SNMP clients to set device settings through SNMP

Administration
X.509 Certificate/Key Enable Simple Network Management Protocol (SNMP) traps

Management Trap Destinations:
Backup/Restore

Update Firmware Primary: (Name or IP address)
Factory Default Settings Secondary: (Name or IP address)
System Information
Reboot
Generate authentication failure traps
Logout

Generate login traps

Generate cold start traps

Apply
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¢ Enable Simple Network Management Protocol (SNMP): This checkbox enables or disables the use of SNMP.

The Public community and Private community fields specify passwords required to get or set SNMP-managed

objects. Changing public and private community names from their defaults is recommended to prevent

unauthorized access to the device.

= Public community: The password required to get SNMP managed objects. The defaultis public.
= Private community: The password required to set SNMP managed objects. The default is private.

* Allow SNMP clients to set device settings through SNMP: This checkbox enables or disables the capability for users
to issue SNMP “set” commands use of SNMP read-only for the AnywhereUSB.

e Enable Simple Network Management Protocol (SNMP) traps: Enables or disables the generation of SNMP traps.
Find checkboxes at the bottom of the page for the SNMP traps: authentication failure, login, cold start, and link up

traps.
Security settings
On the Security page, you can specify the authentication information required for logging into the AnywhereUSB web
Ul or CLI.
‘ﬂ_ AnywhereUSB/5 MHC Configuration and Management
1)
@ Help
C':':tigg::tin" ~ Administrator Password
System Specify the authentication credentials for the Administrator that will be required for logging into the device. After
Remote Management changing the user name or password, you will immediately be asked to log back in to the web interface using the new
Securit: values,
Applications User Name:

RealPort USB

Management

") Enable password authentication
Connections

New Password:
Administration
X.509 Certificate/Key
Management
Backup/Restore
Update Firmware
Factory Default Settings
System Information
Reboot

Confirm Password:

| Enable SSH public key authenticatien

Type or paste your SSH public key here

Logout

2pply |

By default there is no password authentication. If you are using the AnywhereUSB CLI or the web Ul, there is no login

prompt.

If desired, you can enable password authentication. After changing the user name or password, you will immediately

be asked to log back in to the web Ul using the new values.
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Applications (AnywhereUSB/5M and AnywhereUSB/14)

The RealPort USB Configuration page under Applications allows you to configure the Groups feature for the multi-
host devices (AnywhereUSB/5M and AnywhereUSB/14). You can assign each USB port of (AnywhereUSB/5M and
AnywhereUSB/14) to a single group. You can connect only one host computer to a group. Unassigning a port makes it
unavailable to any host computer. Use the RealPort USB Configuration page to configure groups.

‘ﬁ AnywhereUSB/5 MHC Configuration and Management
ians
@ Heb

Home) RealPort USB Configuration

Configuration RealPort USB Settings

Network

System Default Group?  [Group 1 v

Remote Management

Security USB Port 1 Group 1 v

. USB Port 2 Group 2 v

DF:]e:\::u:rLIJSSB USB Port 3 Group 3 v

" ¢ USB Port 4 Group 4 v

lanagement

Conge:tiuns UsePorts [Groups v

Administration 1 pefault Group is being deprecated and can no longer be changed.

X.5009 Certificate/Key

Management I

Backup/Restore LApoly |

Update Firmware

Factory Default Settings

System Informaticn

Reboot

Logout
The Connection Management page displays additional information about the current connections to the

AnywhereUSB.

The example below shows a USB connection to a host computer with an IP address of 192.168.1.52.

‘@l AnywhereUSB/5 MHC Configuration and Management
o]i

e Help

Home

Connections Management

Configuration

Network Active System Connections
System
Remote Management Action Connected From Connected To Protocol Sessions
Security local host 192.168.1.52 (Group 1)  Realport USB 1]
Applications
RealPort USB Refresh Disconnect
Management

Connections
Administration

X.509 Certificate/Key

Management

Backup/Restore

Update Firmware

Factory Default Settings

System Information

Reboot

Logout

Clicking Disconnect will only temporarily disconnect the session. Since the connection request is driven by
the host computer, the session will automatically get re-established.

Click Disconnect only for troubleshooting purposes, such as when instructed by Digi Technical Support.

If you need to disconnect the device from a host computer, use Disconnect in the AnywhereUSB Remote Hub
Configuration Utility.
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Administration

Administration tasks for the AnywhereUSB include certificate and key management, backing up and restoring device
configurations, updating firmware, restoring the device configuration to factory defaults, viewing system
information, and restarting the device. As with device configuration and monitoring, it covers performing
administrative tasks through a variety of device interfaces.

The Administration section of the web Ul main menu provides the following menus:

* X.509 Certificate and Key Management: For configuring security.

* Backup/Restore: For backing up or restoring a device's configuration settings.

e Update Firmware: For updating firmware, including Boot code.

e Factory Default Settings: For restoring a device to factory default setting.

e System Information: For displaying general system information for the device and device statistics.

e Reboot: For restarting the device.

X.509 Certificate and Key Management

The AnywhereUSB devices use X.509 certificates and public/private host key pairs as part of their public key
infrastructure (PKI) based security. Configure and install a digital certificate on the device to encrypt traffic to and
from the device.

This is an optional setting that allows a host computer to confirm AnywhereUSB device authenticity and to encrypt
USB-over-IP traffic. This digital certificate must be signed by a Trusted Certificate Authority (CA). Since an
AnywhereUSB is not publicly accessible, an enterprise CA can self-sign the digital certificate.

AnywhereUSB/5 MHC Configuration and Management

© Helb

Home X.509 Certificate and Key Management

Configuration

Network ¥.509 certificates and public/private host key pairs are an integral part of public key infrastructure (PKI) based security.
System The Certificate Authority (CA) database is used to load certificate authority digital certificates. A certificate authority (CA) is a trusted third
Remote Management party which issues digital certificates for use by other parties. Digital certificates issued by the CA contain a public key. The certificate alsa
Security contains information about the individual or organization to which the public key belongs. A CA verifies digital certificate applicants’ credentials.
The CA certificate allows verification of digital certificates, and the information contained therein, issued by that CA.
Applications
RealPort USB The Certificate Revocation List (CRL) database is used to load certificate revocation lists for loaded CAs. A certificate revocation list (CRL) is a
file that contains the serial numbers of digital certificates issued by a CA which have been revoked, and should no longer be trusted. Like Cas,
Management CRLs are a vital part of a public key infrastructure (PKI). The digital certifiicate of the corresponding CA must be installed before the CRL can be
Connections loaded.
Administration The Secure Sockets Layer (S5L) and Transport Layer Security (TLS) databases are used to load host certificates and keys, as well as
2,509 Certificate/Kev peer certificates and revocations.
Management
Backup/Restore The Secure Shell (SSHv2) Hostkeys database is used to load host private keys. SSHv2 host keys are used for authentication with SSHv2

Update Firmware clients and secure key exchange. A default 1024-bit DSA key is generated automatically if none exists when the device boots.

Factory Default Settings
System Infoermation
Reboot

The administrater's SSHv2 user public key is configured here.

» Certificate Authorities (CAs) / Certificate Revocation Lists (CRLs)
Logout
P Secure Sockets Layer (SSL) / Transport Layer Security (TLS) Certificates

» Secure Shell (SSH) Hostkeys
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Backup/restore settings

Once the AnywhereUSB is configured, backing up the configuration settings using the Backup/Restore page is
recommended in case problems occur later, firmware is upgraded, or hardware is added. When configuring multiple
devices, use the backup/restore feature as a convenience, where the first device's configuration settings are backed
up to afile, and then the file is loaded onto the other devices.

‘ﬁ AnywhereUSB/5 MHC Configuration and Management
o

@ Help
e Backup/Restore

Configuration

Network Backup configuration te a file on your PC or server.

System .

Remote Management Include encrypted passwords and keys in the backup file.

Security Read important security information about using this option.
Applications .

RealPort USB. Backup You will be prompted for where to save the backup file.
Management Restore configuration from a file en your PC or server.

Connections
Note: If the restored configuration medifies the network settings, your Digi device server will dynamically switch to the new settings. You will need

Administration to manually redirect your browser to the new IP address.
X.509 Certificate/Key
Management Restore From File: Choose File | No file chosen
Backup/Restore
Update Firmware M

Factory Default Settings
System Information
Reboot

Logout

Update firmware

From the Update Firmware page, update the firmware for the AnywhereUSB from a file on a computer.

‘ﬁ AnywhereUSB/5 MHC Configuration and Management
DI

@ Help
Home Update Firmware

Configuration
Netwark Caution: You have asked to update the firmware on your AnywhereUSB/S MHC. When updating the firmware, please check the support
5t site and release notes for more information to determine if this device must update the POST before updating the firmware.

System
Revae Management Model:  AnywhereUSB/5 MHC
Security Firmware:  1.81.15.59 (build 82002581_L1 awusb5m eos 1/26/2015 5:21:46p)
Applications POST: 1.09.9.32 (release 82001552_A generic_travis hwdiag 8/27/2009)
RealPort USB
Management Select Firmware

Connections Select Firmware: Cheose File | No file chosen

Administration

X.509 Certificate/Key Update
Management
Backup/Restore

Update Firmware
Factory Default Settings
System Information
Reboot

Logout
Update firmware from a file on a computer:

1 From the main menu, select Administration > Update Firmware. The Update Firmware page is displayed.

2 Enterthe name of the firmware file in the Select Firmware field, or click Browse to locate and select the firmware
file.

3 Click Update. DO NOT close the browser until the update is complete and a restart prompt appears.
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Factory default settings

There are several ways to reset the device configuration of an AnywhereUSB device to the factory default settings:
from the web Ul, using the boot command from the command line, and using the Reset button on the front panel.

The Reboot from the web Ul and boot command are soft resets, while the Reset button/signal method is a hard reset.

Restoring the AnywhereUSB to its factory default settings clears all current configuration settings. In addition, any
files loaded into the device through the File Management page are also removed. If the Keep network settings
checkbox is checked, the network settings will not be reset.

Using the restore operation from the web Ul is the best way to reset the configuration. Before performing the restore
operation, back up the settings using the Backup/Restore operation to save the current configuration in case you
want to restore it at a later time.

‘ﬁ AnywhereUSB/5 MHC Configuration and Management
o)

@ Help

Homs) Factory Default Settings
Configuration
Network
System
Remote Management
Security

Caution: Restoring the factory default settings will clear all current settings and automatically reboot the AnywhereUSB/S MHC.

¥ Keep network sattings

Restore |

Applications
RealPort USB

Management
Connections

Administration
¥.509 Certificate/Key
Management
Backup/Restore
Update Firmware
Factory Default Settings
System Information
Reboot

Logout

Using the web Ul

The Factory Default Settings operation from the web Ul clears all current settings, resets the password for the
administrative/root user, and restores the settings to the factory defaults.

1 Make a backup copy of the configuration using the Backup/Restore operation.

2 From the Main menu, click Administration > Factory Default Settings. The Factory Default settings page is
displayed.

3 (Optional) Check the Keep network settings checkbox to keep the current network settings such as the IP
address and host key settings. In addition, any files that were loaded into the device through the File Management
page such as custom-interface files and applet files are retained.

4 Click Restore.
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Using the boot command
For details, see Configure from the command line on page 51.

From the command line, the boot action=factory command clears all current configuration settings, except the IP
address settings, host key settings, and password for the administrative/root user; restores the settings to the factory
defaults; then restarts the device.

#> boot action=factory

There are several other options for using the boot command to load configuration settings. Type help boot to see all
command options.

Using the front panel Reset button

If the AnywhereUSB is not accessible from the web Ul, restore the configuration to factory defaults using the Reset
button.

1 Disconnect power from the AnywhereUSB.

2 Hold down the front panel Reset button.

3 While holding the Reset button down, connect power to the AnywhereUSB.
4 Wait about 10 seconds, until the System Status LED blinks a Red 1-5-1 code.
5

Release the Reset button.

System information

System information displays the model, MAC address, firmware version, and boot version of the AnywhereUSB
device. It also displays memory statistics, CPU utilization, and how long the device has been running since the last
power-on or restart.

From the web Ul menu, select Administration > System Information. Select General, Network, or Diagnostics for
the appropriate information.

A AnywhereUSB/5 MHC Configuration and Management
\Dign’
@ Help

Home) System Information
Configuration + General

Network

Ses Model:  AnywherelSB/S MHC

Remote Management Ethemet MAC Address:  00:40:9D:8A:81:A8

Security
Applications Firmware Version: ~ 1.81.15.69 (build 82002581_L1 awusbSm eos 1/26/2015 5:21:46p)

RealPort USB Boot Version:  1.09.9.86 (release 82002236_8 awusb5 bootloader 8/31/2009)
Management POST Version:  1.09.9.32 (release 82001552_A generic_travis hwdiag 8/27/2009)

Connections Product VPD Version:  none
. Product.]Df 0x0124

X.500 Certificate/Key Hardware Strapping:  0x0000

Management

Backup/Restore CPU Utilization: 1%

Update Firmware Up Time: 1 day 4 hours 50 seconds

Factory Default Settings Total Memory: 131072 KB

Sustem Infuration Used Memory: 8014 KB

Reboot .

boo Free Memory: 123058 KB
Logout —_
Refresh
» Network
» Diagnostics
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Reboot the AnywhereUSB

Changes to some device settings require saving the changes and rebooting the AnywhereUSB.
To reboot the device from the web Ul:

1 Select Administration > Reboot.

2 Click Reboot. Wait approximately 1 minute for the reboot to complete.

To reboot the device using the front panel Reset button:

1 Hold down the front panel Reset button for about 2 seconds, until the front panel LEDs start blinking an amber
color.

2 Quickly release the Reset button then hold it down again.
3 Wait about 4 seconds, until the front panel LEDs flicker then turn off.

4 Release the Reset button.

Note Thisreboot procedure is only applicable when the AnywhereUSB is in a normal operational state, such as
when the System Status LED is blinking green. If the System Status LED is repeatedly blinking red (instead of
slow green), please contact Digi Technical Support at www.digi.com/support.
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Configure from the command line

This chapter explains how to configure the AnywhereUSB from the command line interface (CLI). Configuring an
AnywhereUSB through the CLI consists of entering a series of commands to set values in the device.

Note This feature is not available on the first generation AnywhereUSB/5.

Access the command line interface
To configure devices using commands:
1 Connectthe AnywhereUSB to a computer.

2 Open aterminal program that can perform both telnet and SSH from a command prompt and connect to the
device using the following settings:

= Connection Port: Connect to the COM port associated with the serial port connected to the device.
= Baud rate or Bits per second: 9600

=« Data: 8 bit

= Parity: None

» Stop:1bit

=« Flow control: Software

Note For AnywhereUSB/14 and AnywhereUSB TS44 models, you can use a null modem serial cable connected to a
serial port on the device to console into the device.

3 Typetelnetip-address at the command prompt, where ip-address is the IP address of the AnywhereUSB, such as
192.168.1.0.

If the AnywhereUSB device requires a username and password, a login prompt is displayed. If the user name and
password for the device are unknown, contact the system administrator who originally configured the device.

AnywhereUSB 2/5/5M/14/TS44 User Guide 51



Supported commands

Supported commands
To verify whether an AnywhereUSB supports a particular command, online help is available. For example:
e Typing help or ? displays all supported commands for a device.

* Typing set ? displays the syntax and options for the set command. Use this command to determine whether the
device includes a particular “set” command variant to configure various features.

e Typing help set displays syntax and options for the set command.

The following table provides some common configuration commands for modifying settings on the AnywhereUSB.

To configure: Use this command:
System-identifying information set system

Host name set host

Network options set network

Network services set service

Ethernet set Ethernet

Users and passwords set user and newpass

For more information about CLI commands, visit www.digi.com/resources and search for the Digi Connect Family
Command Reference guide.

AnywhereUSB 2/5/5M/14/TS44 User Guide 52


http://www.digi.com/resources

Hardware specifications

This section provides the physical dimensions, environmental, and power requirements of the AnywhereUSB.

AnywhereUSB/2

Dimensions

Length: 2.38 in (6.04 cm)
Width:3.9in (10 cm)
Height: 1.0 in (2.54 cm)
Weight: 5 0z. (142 g)

Environmental

Operating temperature: 32° F to 131° F (0° C to 55° C)

Relative humidity: 0% to 95% (non-condensing)

Power requirements

The AnywhereUSB uses a 120/230VAC 50/60Hz power adapter that supplies 5VDC to the device. It is recommended
that only the enclosed power supply be used with the AnywhereUSB. However, power is supplied to the
AnywhereUSB by a UL-Listed Direct Plug-In Power device or Information Technology Equipment Rated Power device
rated 5VDC, at least 3.0 A, if used in the U.S. and Canada or a power supply with similar rating and approved by your
local safety code if it is used elsewhere. For polarity, see the following diagram:

*—
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AnywhereUSB/5 (G2), AnywhereUSB/5 M

Hardware interface features

The device provides 2 USB ports (standard A-type receptacles). The downstream ports support Low, Full, and High
Speed downstream devices.

Memory: 64MB RAM

Network interface features

Standards: IEEE 802.3, 802.3i (10Base-T), 802.3u (100Base-TX), 802.3x (full duplex and flow control), HP Auto-MDIX
(auto-detection of straight-through or crossover cabling)

Physical layer: 10/100 Mbps in half- or full-duplex mode, with auto-negotiation of speed and duplex

Ethernet connector: RJ-45

AnywhereUSB/5 (G2), AnywhereUSB/5 M

Dimensions

Length: 4.35in (11.05 cm)
Width: 7.20in (18.29 cm)
Height: 1.03in (2.61 cm)
Weight: 10.00 oz. (283.5g)

Environmental

Operating temperature: 32° F to 131° F (0° C to 55° C)

Relative humidity: 0% to 95% (non-condensing)

Power requirements

The AnywhereUSB uses a 120/230VAC 50/60Hz power adapter that supplies 5VDC to the device. It is recommended
that only the enclosed power supply be used with the AnywhereUSB. However, power is supplied to the
AnywhereUSB by a UL-Listed Direct Plug-In Power device or Information Technology Equipment Rated Power device
rated 5VDC, at least 3.0 A, if used in the U.S. and Canada or a power supply with similar rating and approved by your
local safety code if it is used elsewhere.

For polarity, see the following diagram:

3

Note The power supplies between the AWUSB/5 first and second generation (G2) models are not interchangeable.
Use the power supply provided with the device.
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AnywhereUSB/5 (first generation)

Hardware interface features

The device provides 5 USB ports (standard A-type receptacles). The downstream ports support Low, Full, and High
Speed downstream devices.

Memory: 128MB RAM

Network interface features

Standards: IEEE 802.3, 802.3i (10Base-T), 802.3u (100Base-TX), 802.3x (full duplex and flow control), HP Auto-MDIX
(auto-detection of straight-through or crossover cabling)

Physical layer: 10/100 Mbps in half- or full-duplex mode, with auto-negotiation of speed and duplex

Ethernet connector: RJ-45
AnywhereUSB/5 (first generation)

Dimensions

Length: 4.35in (11.05 cm)
Width: 7.20in (18.29 cm)
Height: 1.03in (2.61 cm)
Weight: 10.00 oz. (283.5g)

Environmental

Operating temperature: 32° F to 131° F (0° C to 55° C)

Relative humidity: 0% to 95% (non-condensing)

Power requirements

Power to this product many be supplied by a UL Listed Direct Plug-In Power device marked “Class 2" or a UL listed
power supply rated with a minimum rating of 5V DC 2.5 A if used in the U.S. and Canada or a power supply with
similar rating and approved by your local safety code if it is used elsewhere.

For polarity, see the following diagram:

¢ ©

Note The power supplies between the AWUSB/5 first and second generation (G2) models are not interchangeable.
Use the power supply provided with the device.
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AnywhereUSB TS44

AnywhereUSB TS44

Dimensions

Length: 4.35in (11.05 cm)
Width: 7.20in (18.29 cm)
Height: 1.03in (2.61 cm)
Weight: 10.00 oz. (283.5g)

Environmental

Operating temperature: 32° F to 131° F (0° C to 55° C)

Relative humidity: 0% to 95% (non-condensing)

Power requirements

The AnywhereUSB uses a 120/230VAC 50/60Hz power adapter that supplies 5VDC to the device. It is recommended
that only the enclosed power supply be used with the AnywhereUSB. However, power is supplied to the
AnywhereUSB by a UL-Listed Direct Plug-In Power device or Information Technology Equipment Rated Power device
rated 5VDC, at least 3.0 A, if used in the U.S. and Canada or a power supply with similar rating and approved by your
local safety code if it is used elsewhere.

For polarity, see the following diagram:

o{e®

Hardware interface features

The device provides 4 USB ports (standard A-type receptacles) and 4 serial ports. The downstream ports support Low,
Full, and High Speed downstream devices.

Memory: 128MB RAM

Serial interface features

e 10-pin serial ports

e EIA-232 interface

e Throughput up to 230,400 bps
e 5 6,7,8databits

e 1,1.5,2stop bits

e Mark/space/even/odd parity

e Hardware and Software Flow Control
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AnywhereUSB/14

Serial port pinouts

Pin1 RI

Pin 2 DSR

Pin 3 RTS

Pin 4 Ground

Pin5 TxD

Pin6 RxD

Pin7 Signal Ground
Pin 8 CTS

Pin9 DTR

Pin10 DCD

Network interface features

e Standards: IEEE 802.3, 802.3i (10Base-T), 802.3u (100Base-TX), 802.3x (full duplex and flow control)
e Physical layer: 10/100 Mbps in half- or full-duplex mode, with auto-negotiation of speed and duplex
e Ethernet connector: RJ-45

AnywhereUSB/14

Dimensions

Length: 4.97 in (12.62 cm)
Width: 17.00 in (43.18 cm)
Height: 1.74 in (4.42 cm)
Weight: 40.00 oz. (1134g)

Environmental

Operating temperature: 32° F to 131° F (0° C to 55° C)

Relative humidity: 0% to 95% (non-condensing)

Power requirements

The AnywhereUSB/14 uses single or dual 120/230VAC 50/60Hz power input(s) through the rear IEC 60320 inlet(s).
Redundant (dual) supply enables it to support mission critical applications where uninterrupted powering is a must.
In case of redundant (dual) powering, both supplies provide power to the device. When one of the supplies fails the
other will provide the complete power to the device. In case of single powering, use the left side inlet (rear view). The
maximum power requirement of the AnywhereUSB/14 is 40W.
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AnywhereUSB/14

Hardware interface features

The device provides 14 USB ports (standard A-type receptacles). The downstream ports support Low Speed, Full
Speed, and High Speed downstream devices.

The device supports two Ethernet connectors (dual RJ-45) LAN1 & LAN2 for mission critical applications (redundant
Ethernet). The device can switch from LAN1 to LAN2 and vice-versa if any of them fails. The primary input is LAN1.

The device also provides an RS232 UART Management port via a DB9 connector at the rear next to the network
connectors.

Network interface features

Standards: IEEE 802.3, 802.3i (10Base-T), 802.3u (100Base-TX), 802.3x (full duplex and flow control), HP Auto-MDIX
(auto-detection of straight-through or crossover cabling)

Physical layer: 10/100 Mbps in half- or full-duplex mode, with auto-negotiation of speed and duplex
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Regulatory and safety information

GOST certification

Safety information

I'Ipo,quu,vm COOTBETCTBYET Tp66OBaHI/I9|M HOPMAaTUBHbIX JOKYMEHTOB:

rOCT P M3K 60950-1-2009, TOCT P 51318.22-99, FTOCT P 51318.24-99, TOCT P 51317.3.2-2006 (Pa3a. 6, 7), TOCT P
51317.3.3-2008
Transitional CoC No + issuing/expiration dates

Ne POCC US.MH08.B02068
Cpok geincteus ¢ 14.02.2013 no 13.02.2014

Address and phone of service facility

Digi International Inc. 10000 West 76th Street, Eden Prairie, MN 55344, CLLIA

' WARNING!  Forthe AnywhereUSB/14 only: HAZARDOUS VOLTAGE INSIDE. Before servicing any device, make sure
the power is disconnected.
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Troubleshooting

The following information provides troubleshooting steps for the most common issues. To find information on other
issues, visit our Knowledge Base at knowledge.digi.com.

Basic troubleshooting steps

Follow these basic troubleshooting steps first:

e Make sure you have the most current driver and firmware installed for your AnywhereUSB model and USB
devices.

¢ Make sure each USB device has the most current drivers installed.

e Make sure the USB device works as expected using a native USB port by connecting the USB device directly to the
computer instead of through an AnywhereUSB.

e Trythe "Use Microsoft IDs" AnywhereUSB option, see the Understanding the “Use Microsoft IDs” AnywhereUSB
feature Knowledge Base article.

AnywhereUSB error when connecting on a virtual machine

When the AnywhereUSB status says “Connected to this computer” but shows a warning icon with error code 39 in
Device Manager, the virtual machine might be missing the necessary USB drivers.

The virtual machine must have a USBD.SY_ or usbd.sys file located in the ...\system32\drivers folder. If this file is
missing, do the following:

1 Make sure Windows is configured to show file extensions.
Windows XP:

a Open My Computer, select Tools > Folder Options, and click the View tab.

b Scroll down and clear the Hide extensions for known file types check box and click OK.
For Windows 7 and Server 2008:

a Open Computer and select Organize > Folder and Search Options.

b Click the View tab.

¢ Scroll down and clear the Hide extensions for known file types check box and click OK.
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AnywhereUSB USB device compatibility list

2 Onthe Windows virtual machine drive, search for the usbd.sys file.
The exact location of this file depends on the Windows operating system version:

«  XP 32-bit: i386 folder

= XP 64-bit: I1A64 folder

= Server2003:i386 folder

= Server2003 R2:i386\DRIVER.CAB

= Server 2008: sources\install.wim\5\Windows\System32\drivers\
» Vista: sources\install.wim\5\Windows\System32\drivers\

= Windows 7: sources\install.wim\4\Windows\System32\drivers\

Note For newer operating systems with the install.wim file, we recommend using software such as 7-Zip to browse
the contents of the install.wim file to locate the USBD.SY_ or usbd.sys file.

3 Copythe USBD.SY_or usbd.sys file and paste it in the ...\system32\drivers folder on the virtual machine. If you are
copying the USBD.SY_file, rename it to usbd.sys. Make sure to paste it in the drivers subfolder, not system32.

4 Restart the virtual machine.

5 After Windows loads, the AnywhereUSB Host Controller(s) and AnywhereUSB/RealPortUSB Root Hub(s)
component(s) should automatically install and appear in Device Manager.

AnywhereUSB USB device compatibility list

The AnywhereUSB is a network-attached USB 2.0 hub. While any USB device should work, there are some limitations.
Use the following information to make sure your USB device is compatible with AnywhereUSB.

Note USB 2.0 supportwas introduced in AnywhereUSB firmware v1.51 for the AnywhereUSB/5 (G2), AnywhereUSB/
5M, AnywhereUSB/5 (G2) TS-44, and AnywhereUSB/14 models. The AnywhereUSB/2 model introduced USB
2.0 support in firmware v1.60. All previous firmware versions are USB 1.1. The first generation AnywhereUSB/
5 supports only USB 1.1.

Compatible USB devices

The following list provides some of the USB devices that are compatible with the AnywhereUSB that we recommend
and support, but it is not a complete list:

e USB license dongles, also known as security keys or license keys. All brands work, such as SafeNet, WIBU,
Rockey4, Aladdin, HASP, and so on

e USB printers, scanners, or multi-function devices

e USBHID (human interface device), such as mice, keyboards, barcode scanners, and magnetic strip card readers
e USB hubs, such as the Digi Hubport product line

e USB-to-serial converters, such as the Digi Edgeport product line

e Digi Rapidport modem bank

e Digi Watchport USB cameras

e Other bulk or interrupt (per USB spec) type USB devices

e Lab style instruments

¢ Smartphones
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No remote hubs found

Limited support USB devices

The following USB devices have limited support with the AnywhereUSB. We do not recommend using these devices,
because they have limited testing. However, they may work for your application.

e USB mass storage devices, such as flash drives and hard drives

Note These devices should enumerate, possibly slower than expected, and might have a noticeable performance
decrease compared to a native USB port. Expect transfer rates at about 4-6 Mbit/sec due to various
considerations, such as network overhead.

Incompatible USB devices

The following USB devices are incompatible with the AnywhereUSB. We do not recommend or support using them:

* "Isochronous" (per USB spec) devices. Check the spec sheet of the USB device or contact the vendor to determine
if a device uses the "isochronous" USB transfer type

e USB audio devices, such as sound cards

e Video streaming devices, such as webcams, except for the Digi Watchport USB cameras

USB Modems, except for the Digi Rapidport modem bank

USB modems

If you need to use a USB modem, we suggest using a Digi Edgeport USB-to-serial converter with a RS-232 serial
modem, which we have successfully tested. Although any serial modem should work, we specifically recommend
MultiTech 5634ZBA, US Robotics 5686 based on positive feedback from customers. Some customers have also
reported success with US Robotics USR5637 and Multi-Tech MT9234-CDC-XR USB modems, though they are not
supported because Digi has not yet tested these devices.

No remote hubs found

The “No remote hubs found” message appearing on the left side of the AnywhereUSB Remote Hub Configuration
Utility indicates that the host computer is unable to discover any AnywhereUSB devices on the network.

This message appears when firewall software blocks the port used for device discovery. Try the following:
e Forfirewall software, either disable it or add an exception for the port.

e Check fora link light on the AnywhereUSB Ethernet port. If the link light is not lit, connect all of the AnywhereUSB
devices to switches using network cables.

e Connect the AnywhereUSB device directly to the host computer.

= First generation AnywhereUSB/5: You must use a crossover network cable to connect first generation
AnywhereUSB/5 devices to the host computer.

= Second generation AnywhereUSB devices: Use the auto-sensing network interface on the second generation
AnywhereUSB models to connect to the host computer,

e Ifthe host computer has multiple network interfaces, disable the network interfaces that are not on the same
network as the AnywhereUSB device. Then close and re-launch the AnywhereUSB Remote Hub Configuration
Utility.
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USB license dongle cannot be found

By default, the AnywhereUSB Remote Hub Configuration Utility only searches the local subnet for AnywhereUSB
devices. If the AnywhereUSB device is on a different subnet, you must configure the AnywhereUSB Remote Hub
Configuration Utility to look on the other subnet:

a Usethe Device Discovery Utility to determine the AnywhereUSB device IP settings (for all models except the
first generation AnywhereUSB/5).

b Inthe AnywhereUSB Remote Hub Configuration Utility, click Edit / Discovery List and either add the
AnywhereUSB IP address or add the other subnet in question, such as192.168.1.255.

Some anti-virus software might block the connection. You can either temporarily disable it or add an exception
for the AnywhereUSB Remote Hub Configuration Utility executable:

« For 32-bit operating systems, allow AwUsbCfg.exe.
» For 64-bit operating systems, allow AwUsbCfg64.exe.

For first generation AnywhereUSB/5 devices: If the System Status LED is solid orange and all five port LEDs are off,
the device is configured with the DHCP client enabled and is unable to obtain an IP address. Perform a factory
reset (see AnywhereUSB factory reset procedure).

USB license dongle cannot be found

Try these suggestions in the following order:

1

Make sure the license information on the dongle has not expired, contact the appropriate dongle/software
vendor.

Make sure the USB license dongle is functioning correctly:

a Connectitdirectly to a physical computer (not to an AnywhereUSB device).

b Install the proper dongle driver and confirm that the dongle is installed properly by checking Windows Device
Manager.

¢ Ifyou have software to test the dongle, run the software to make sure the dongle is working properly. If the
dongle does not work, it will likely not work with an AnywhereUSB device.

Make sure that another USB device works on the same AnywhereUSB port, such as a USB keyboard or mouse.

Make sure that you are running the most current AnywhereUSB driver and firmware versions on the host
computer.

Make sure the computer has the most current dongle driver version.

Start the AnywhereUSB Remote Hub Configuration Utility and do the following:
a Select File > Preferences,

b Select the Use Microsoft Device IDs check box and click Save,

¢ Disconnect from the AnywhereUSB device then re-connect to the device.

If you are launching the protected software from a computer connected through a Windows Remote Desktop
Session, you need to use the console option instead to connect directly to the computer and then run the
software.

Add the dongle as a permitted device based on its PID/VID, as follows:

a Openthe AnywhereUSB Viewer Utility,

b Inthe AnywhereUSB program group, select the USB device and make note of the VID (Vendor ID) and PID
(Product ID) of that device. Each ID should be four characters, in HEX format, such as 0x1234. Ignore the
leading Ox when taking note of the values.
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Connecting to this computer message

¢ Usingthe Windows Registry Editor, go to
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\ionhub.

d Withionhub selected, select Edit > New > Multi-String Value.
e Rename the new value to PermittedDevices (case sensitive).

Double-click PermittedDevices and in the Value data field, type Vid_1234&Pid_5678 (where 1234 is the
Vendor ID and 5678 is the Product ID of the USB device).

g Click OK and close Registry Editor.

h Restart the host computer.
9 Disable Windows Data Execution Prevention.

10 If the parallel port is not used, disable it in the host computer’s BIOS.

Note Avirtual machine has a BIOS. When the computer running the virtual machine does not have a physical
parallel port, the option might be in the BIOS of the virtual machine.

For details, see Appendix A: AnywhereUSB permitted device list on page 66.

Connecting to this computer message

When a device remains in the “Connecting to this computer” state in the AnywhereUSB Remote Hub Configuration
Utility. The following are the most common causes.

Firewall software

Firewall software, such as Windows Firewall, may be blocking port 3422 TCP that the AnywhereUSB uses. Either add
this port as an exception or disable the firewall software.

Windows New Hardware Wizard

The Windows New Hardware Wizard did not open when you connected the AnywhereUSB device. To resolve this
issue:

1 Open Device Manager and find AnywhereUSB-related components that have a warning icon.
2 Right-click the components that have the warning icon and click Update Driver.

3 Complete the installation procedure.
4

Repeat this process as needed for all AnywhereUSB-related components in Device Manager that have warning
icons.

AnywhereUSB is connected to a different computer

The AnywhereUSB may already be connected, or trying to connect, to a different computer. This applies only to
AnywhereUSB models that connect all of the USB ports to a single host computer, such as legacy AnywhereUSB/5,
AnywhereUSB/2, AnywhereUSB/5 (G2), and AnywhereUSB TS44 devices. To resolve this issue:

1 Openthe AnywhereUSB Remote Hub Configuration Utility.
2 Select Edit > Connect List.

3 Delete the IP address of the affected AnywhereUSB device and close the Connection List.
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Connecting to this computer message

4 Make note of the deleted device’s status in the Host PC Connection Status window and do the following:

= Statusis "Connected to (IP address)": The AnywhereUSB is already connected to a different host computer.
First, disconnect from the other host computer by removing the AnywhereUSB device's IP address from the
Connection List. Then reconnect the device to the desired host computer.

= Statusis "Available for Host Connection": There is another issue that is causing the problem. Contact Digi
Technical Support for assistance.

Check the network configuration

If the AnywhereUSB is configured with a static IP address (with the DHCP client disabled), check the following:

e Determine if the AnywhereUSB's Static IP address is in use by another device on the network by disconnecting the
network cable from the AnywhereUSB device, then try to ping that same IP address from the host computer. If you
get a ping reply, then another device on the network is using the same IP address.

Note Using ping may not provide reliable results because not all devices respond to this command. We
recommend configuring the AnywhereUSB device with a different static IP address that is outside of the DHCP
range if a DHCP server is on the network.

e Make sure the subnet mask is correct.
e Make sure the host computer’s IP address is correct, especially when configured with a static IP address.

e Make sure the host computer’s network configuration is properly configured so it communicates with the
AnywhereUSB device. Also, make sure they are both on the same subnet.

e Pingthe AnywhereUSB device. If you do not get a response, then you will not be able to connect to the device.

Reinstall the AnywhereUSB software

If none of the troubleshooting suggestions help, uninstall the AnywhereUSB software, reboot the host computer, re-
install the AnywhereUSB software (with admin privileges), and connect to the AnywhereUSB again.
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Appendix A: AnywhereUSB permitted device list

About the permitted device list

An option has been added to the AnywhereUSB product that limits access to a set of select devices. This option allows
an administrator to build a list of supported devices by adding specific Vendor ID/Product ID or Class values into the
registry. The AnywhereUSB will compare the IDs of each USB device (when the USB device is connected), with the
value(s) in the registry and if there is a match, the device will enumerate; otherwise an “unknown device” message
will appear in the Notification Area.

The key is located in this location:
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\ionhub

The new key value is PermittedDevices. This Multi String value contains a list of devices that the AnywhereUSB will
enumerate all other devices will show as "unknown device."

Examples
Following are some examples of values in the permitted device list:
e Forahub, use the value GENERICHUB (Class_09 is not supported).
e Foracomposite device, use the value COMPOSITE.
* Forspecific device, use Vid_xxxx&Pid_yyyy where xxxx and yyyy are the vendor id and product ID of the device.
e Foradevice class such as mass storage, use Class_xx where xx is the class of device. Classes are as follows:
= Communications: 02
= Human interface: 03
= Printer: 07
= Storage: 08
« Vendor Specific: FF
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Configure the permitted device list

Configure the permitted device list

To allow a specific USB device with an embedded hub, such as an Edgeport/8:
PermittedDevicesREG_MULTI_SZVid_1608&Pid_0215 GENERICHUB

To allow all human interface devices such as mouse or keyboard:
PermittedDevicesREG_MULTI_SZClass_03

To allow all mice and all printers:
PermittedDevicesREG_MULTI_SZClass_03 Class_07

Use the AnywhereUSB View utility to see the USB device's Vid/Pid values. The fields are called idVendor and
idProduct. In the following example, the highlighted USB flash drive has the following properties:

e idVendor:0x13FE
¢ idProduct:0x1D00

B AnywhereUSB View g@@

File Options Help
= ﬂ My Computer Device Descriptor: A~
# o Intel(R) ICHY Famiy USB Universal Host Controller - 2937 bedUSE: i 0x0200
%o Intel[R) ICHS Family USB Universal Host Controller - 2338 bhevicsClass: 0=00
3 p ; bDeviceSubClass: 0=00
#-¢5 Intel[R] ICHS Famiy USE Universal Host Controller - 2339 bDaviceProtocol - 0=00
# % Intel[R) ICHS Famiy USB2 Enhanced Host Controller - 293C bMaxPacketSizel : 0z40 (64)
# - #% Intel[R) ICH3 Family USB Universal Host Controller - 2334 idVendor: 0x13FE
# ek Irtel(R) ICHS Family USE Universal Host Controller - 2935 idProduct: 0x1D00
# % Intel[R) ICHI Family USE Universal Host Canroller - 2336 i Gaiian 1
i Intel[R) . DiversmLTIO LomIONer iManufacturer: 001
#-#% Intel(R) ICHS Family USB2 Enhanced Host Controller - 2934 0x0409: "Kingston"
=+ Anywherel)SB Host Controller 192.168.0.102 - 0 iProduct : 0=02
5 e RootHub 0x0409: "DataTraveler 2.0"
' sclad LISH i . iSerialNumber: 0x03
z b b 0x0409: "S5B74068C4AD1"
% [Port2] DeviceConnected : USB Mass Storage Device bNumConf igurations: 0=01
=% [Port3) DeviceConnected : TEAC USB CD-ROM Drive ; )
=+ Anywherel)SB Host Controller 192.168.0.102- 1 ConnectionStatus: DeviceConnected
= & RootHub Current Config Value: 0x01
#% [Portl] DeviceConnected : Watchport/V2 USB Camera izig: Eg§r§§:?d, ggéé
+Z+ [Port2] NoDeviceConnected Open Pipes: i
Endpoint Descriptor:
v
< b4
Devices Connected: 7 Hubs Connected: 1 Y

B AnywhereUSB View

File Options Help
= E My Computer Device Descriptor: A
# % |ntel(R) ICHS Family USE Universal Host Controller - 2937 bedUSB: :
%+ Intel(R] ICH3 Family USB Universal Host Controller - 2933 bDeviceClass:
i 1% P s bDeviceSubClass:
# « Intel(R] ICH3 Family USB Universal Host Controller - 2939 bDeviceProtocol :
% £ Intel(R) ICHS Family USB2 Enhanced Host Controller - 293C bMaxPacketSizel: (64)
# =% IntellR) ICHS Family USB Universal Host Controller - 2934
#-#% |ntellR) ICH3 Family USE Uriversal Host Controller - 2935 bed L
+ +%2 Intel(R) ICH3 Farnfiy USB Universal Host Controller - 2336 iHanufactﬁrer: Dx01
# % |ntel(R) ICHS Family USB2 Enhanced Host Controller - 2934 0x0409: "Kingston"
= %2 Anywherel)SB Host Controller 192.168.0.102 - 0 iProduct : 0x02
" & RootHub 0x0409: "DataTraveler 2.0"
=% [Port1] DeviceConnected : USB Mass Storage Device el rar =
z 4 . 9 : 0x0409: "SB7406B8C4AD1"
=% [Port2] DeviceConnected : USB Mass Storage Device bNunConf igurations: 0x01
#5 [Port3] DeviceConnected : TEAC USB CD-ROM Drive . .
= % AnywhereUSB Host Controller 192.168.0.102 - 1 ConnectionStatus: DeviceConnected
= RootHub Current Config Value: 0z01
& ] Device Bus Speed: Full
%5 [Port1] DeviceConnected : Watchport/V2 USB Camera Davica Address: 0x02
«Z+ [Port2] NoDeviceConnected Open Pipes:
Endpoint Descriptor:
v
$ I >
Devices Connected: 7 Hubs Connected: 1 Y

The following is a view of the registry with the new Key of "PermittedDevices":
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Configure the permitted device list

% Registry Editor

Fle Edt View Favortes Help
# (] in910u Al Name Type Data
0 o (2 efauk) REG.52 (vaus rct set)
@ 8 Intellde [sb]isplaytiame REG_57 AnywherelSB Hub Driver
¥ 8 'I““W" [Wemorcontrol REG_DWORD 000000001 (1)
; & .::r::ﬂ e ventLogging REG_DWORD 000000000 (0)

& e REGEXPANDST  system32|DRIVERSYonhub.sys
& seariy REG_MULTL_SZ ¥id_16068Pid_4001 ¥id_16088Fid_4011 Vid_16068#id_4006 Yid_16088Rid_4016 Yid 1.,

& 3 oy REG_DWORD 000000003 (3)
3 itw REG_DWORD 0:00000001 1)
# (1 IpFikerDriver
# (] Iplnlp
® [ Iphiat
# (] Poec
# (] IRENUM
(] I5APISearch
# (] isaprp
i (] Kbdclass 3

< P >

My Computer|HKEY_LOCAL_MACHINEISYSTEM\CurrentControlSet! Serviceslionhub

Double clicking on the key will bring up the Edit Multi-String dialog.

Edit Multi-String

Value name:

PermittedD evices ‘
Value data:

Vid_1608&Pid_4001
Vid_1608&Pid_4011
Vid_1608&Pid_4006
Vid_1608%Fid_4016
Vid_1608%Fid_021b
Vid_1608&Pid_0243
Class_03

Class_08

Class_FF
COMPOSITE
GenericHub

[ 0K J [ Cancel ]
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Appendix B: Understanding hubs

About hubs

Hubs are critical components in the plug-and-play architecture. They are wiring concentrators that enable the
attachment of multiple devices, thus converting a single attachment point into multiple attachment points. USB
architecture allows a cascaded multiple hub configuration with certain power limitations (explained later in this
section). The figure below shows an example of a typical hub configuration.

PC
Host
Hubport

J
W B —
[ Edgaport ”mspomedhu:: canner ]DGG

[ joystick

[ |

Upstream and downstream ports

Each hub has an upstream port, connecting to the host, and multiple downstream ports, connecting to downstream
devices, including other hubs. A hub can detect attachment and detachment of downstream devices and enable and
monitor the distribution of the power to downstream devices via their integral hardware and the operating system.

Power requirements

Each USB device reports its power requirements to the operating system, which then enables and disables the device
as a function of its power requirements and the amount of available power. High-speed devices typically connectto a
self-powered hub, which obtains power from its external power supply and provides up to 500 mA for each
downstream port. Connect only simple devices, such as a mouse, to a bus-powered hub, which obtains power from
its upstream host and provides up to 100 mA for each downstream port.
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Series limits

Due to the limited available power for bus-powered hubs, cascading two bus-powered hubs is an illegal topology,
and devices connected to the second hub will not function. (USB specifications limit the connection of a bus-powered
hub to a self-powered hub or host only.)

Series limits

According to the USB Specification, the maximum limit of hubs cascaded in series cannot exceed five. In other words,
you may have a maximum of five hubs between any device and the host. This does not mean that the maximum
number of hubs in a system is five. Connect up to seven parallel hubs at any given level. You must tally both external
and embedded hubs when counting downstream hubs.
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Appendix C: Firewall support

Configure for firewall support

To access an AnywhereUSB that is behind a firewall:

e Your firewall must have a well known static IP address, for example, 10.52.48.37.

e The AnywhereUSB must have an IP address on the private subnet, for example, 192.168.1.10.

e You must configure your firewall to allow TCP/IP and UDP/IP packets to pass through port 3422.

e You must configure the firewall to send these TCP/IP and UDP/IP packets directed to the IP Address of the
AnywhereUSB; in this example the address would be 192.168.1.10.

e You must manually add the address of the firewall to the Connection List.

Note You can access only one AnywhereUSB through each firewall.

For more information on how to configure your firewall, refer to your firewall manual.
At this point, the computer will attempt to connect to the AnywhereUSB.

If you would like AnywhereUSB information in the discovery window of the AnywhereUSB Remote Hub Configuration
Utility, you can add the address of the firewall into the Discovery List.

Note AnywhereUSB devices behind firewalls, as displayed in the discovery window, show the IP address of their
private network.
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